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Chapter 1 Overview 
1.1 Overview of Color Management System 

Printing is an industry of reproducing, the major issues of which have always been how to 
faithfully reproduce the color, level and definition of the originals. Various devices are 
applied for scanning, displaying, proofing and printing. These devices, however, have 
different color features and color processing abilities. How do you ensure consistent color 
reproduction in different devices? Color Management is the answer.  

Color management is adopted to describe the device-dependent colors in a 
device-independent way so as to ensure color consistency. In 1993, International Color 
Consortium issued the ICC standard, which is used to describe the device-independent 
color characteristic. ICC utilizes the device-independent color space of CIE XYZ and CIE 
Lab as the standard color space, which is also known as PCS (Profile Connection Space). 
The device-dependent RGB or CMYK colors are first transformed to CIE XYZ or CIE Lab 
color spaces, and then transformed to colors that are suitable for different devices. The 
process is shown as in the following figure:  

 
Figure-1 

Color management is a device-independent and cross-platform workflow, which adopts 
the concepts of LAB color space and profiles. RGB and CMYK are device-dependent color 
spaces, which means that the same RGB or CMYK values are interpreted into different 
colors in different devices. Generally speaking, scanners and digital cameras adopt RGB 
space, while printer and press use CMYK space. LAB is a color space that is based on 
human perception of visual stimuli, and that has the largest gamut.  

The application of color management realizes What You See Is What You Get. It can be 
applied in various stages of printing, such as color management for scanner, monitor 
proof system and digital proof.  

1.2 Overview of EagleDot 

Founder has been working hard on providing excellent software on design, production, 
output and workflow. By the end of 1999, Founder released a Plug-in of Digital Proof, 
which was based on Founder EagleRIP, to satisfy publishing requirements in China. 
Nowadays EagleRIP is widely used in Pressroom, Publishing House, Advertising & Design 
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Company, Plate Making Company and Color Paper Publishing House.  

With the development of equipment and market, in 2001, Founder launched the new 
generation of digital proof software—EagleDot, to meet the rapidly increasing 
requirements on digital proof. Later, Founder also makes a lot of innovations to this 
product and launches many new versions continuously.  

EagleDot has its own RIP kernel and excellent Color Management Module (CMM, for 
short). It may be used in Publishing Houses, Ad Agencies, Newspaper Collection Centers, 
and so on. To summarize, EagleDot has the following features: 

High Quality 

EagleDot implements a new dot shape resulting from the extensive research of Founder’s 
R&D Center. This new dot shape ensures smooth gradients and accurate reproduction.  

Color Management 

Adopts new color arithmetic. With the color management functionalities of EagleDot, the 
users can easily and effectively take advantage of their existing proofing environment to 
simulate the press environment. 

Easy to Use 

EagleDot puts all commonly used parameters together. Users can configure parameters 
very conveniently.  

Last Minute Modification 

EagleDot allows users to preview jobs, check parameters, and modify parameters at the 
last minute before printing. If you find that some parameters are not correctly defined, 
you can modify them in time instead of re-RIPping the file. The modified parameters can 
take effect immediately in printing.  

Fast Preview 

The fast preview function is available. EagleDot supports pre-RIPping and post-RIPping 
previews. With the preview function, you can zoom in, zoom out, and rotate according to 
your needs. 

Auto Ganging 

The auto ganging function automatically arranges the position of bitmaps on large size 
output paper, saving time and media. 

Spot Color Proofing 

EagleDot allows you to easily work with spot colors. You can define, edit and calibrate 
individual spot colors separately. 

Black Retain 

EagleDot enables you to print pure black areas with pure black ink. 

Color Tune 

EagleDot provides color tune function. Using the color tune curves generated by the Color 
Tune tool, users can conveniently implement fine adjustment.  

Network Printing 

EagleDot supports you to directly print documents from MAC and Windows PC through a 
network. 

Hot Folder Printing 
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EagleDot provides auto-print function. EagleDot can monitor hot folders that enable the 
auto-print function, locate the files in the folders and process them automatically. 

1.3 Glossary of Terms 

EagleRIP 
It is a registered trademark of Beijing Founder Electronics Co., Ltd. It is a professional 
PostScript 3 interpreter. 

PostScript 
Adobe PostScript, developed in 1985, is a page-description language for printing and 
displaying documents that integrate text, graphics, images, and color. PostScript has 
evolved through successive Language Levels 1, 2, and PostScript 3. Language Level 1 
includes the initial features and commands or "operators" of the PostScript language. 
Language Level 2 expands the functionality of Language Level 1 to include 
device-independent color and improved memory management. PostScript 3 includes all 
the features of Language Levels 1 and 2, and provides further enhancements, which this 
document identifies. 

ICC Profiles 
A profile is a description of how a device interprets and renders color. An ICC compliant 
profile conforms to the standards of the International Color Consortium (ICC). It records 
transformation relationship between device color space and CIE color space. 

DPI (Dots Per Inch) 
DPI describes the number of dots per inch for device. It is the measuring unit for 
resolution.  

TIFF (Tag Image File Format) 
TIFF (Tag Image File Format) is a common format for exchanging raster graphics (bitmap) 
images between application programs, including those used for scanner images. A TIFF 
file can be identified as a file with a ".tiff" or ".tif" file name suffix. The TIFF format was 
developed in 1986 by an industry committee chaired by the Aldus Corporation (now part 
of Adobe Software). Microsoft and Hewlett-Packard were among the contributors to the 
format. One of the most common graphic image formats, TIFF files are commonly used 
in desktop publishing, faxing, 3-D applications, and medical imaging applications. 

EPS (Encapsulated PostScript) 
EPS is acronym for Encapsulated PostScript, which is a standard file format for importing 
and exporting PostScript files. In many applications, image and text information can be 
output in the form of EPS. The purpose of an EPS file is to be included in other pages, 
scaled and moved etc. like an image, but the contents of the EPS cannot be modified. EPS 
is the subset of PostScript, and is used for describing page contents.  

Bitmap/Frame Bitmap 
Bitmap/Frame Bitmap refers to page after RIPping.  

Path 
It describes file location. For example: c:\users\file1. 

System Parameter 
System parameters are important parameters and configuration, which can affect the 
whole EagleDot running. EagleDot has provided default settings for system parameter. If 
you want to know more about them, please refer to Chapter 6 in this manual. 

Parameter Template 
Parameter template is an integration of job parameters. It includes output parameters 
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such as device, resolution, page size, etc. You can create a new template for your job. If 
you want to know more about them, please refer to Chapter 3 in this manual. 

Queue 
Queue is the list of waiting processing files. Usually, jobs in a queue will be processed on 
a first-come-first-serve basis. 

IDIOM 
Idiom Recognition converts less efficient Language Level 2 operators (e.g., 
application-generated contours and iterative shades) into higher-quality, faster-printing 
PostScript 3 operators. 

PPD (PostScript Printer Description) Files 
PostScript® printer description (PPD) files describe the fonts, paper sizes, resolution 
capabilities, and other features that are standard for your PostScript printer. PPD files are 
used by PostScript printer drivers to determine how to print your document. If you do not 
print using the correct PPD file, your document might not print correctly, or not all of the 
printer's features will be available when you print. 
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Chapter 2 
EagleDot Quick Start 
2.1 Install and Uninstall EagleDot 

2.1.1 Install EagleDot 

Operating Systems Supported 

Windows 2000 + SP4 English version 

Windows 2003 + SP1 English version 

Windows XP + SP2 English version 

Windows 7 Professional 32bit 

Recommended Configuration 

CPU: Pentium 4, 2.8 GHz or above 

Memory: 1 GB or above 

Hard Disk: 80 GB or above 

Display: 17 inches or above monitor, true color, 1024X768 dpi or above 

Installation Steps 

In this section, we will introduce you the installation of EagleDot in Windows XP operating 
system. The process on other operating systems may vary a bit, but they are basically 
the same. 

Before you install EagleDot, please plug the dongle for EagleDot into the USB port, and 
connect the digital proof device with the computer while the power is off. Please also 
install the driver for the digital proof device before you install EagleDot. When everything 
is ready, insert the EagleDot CD into the CD-ROM. If auto-play function is enabled, the 
“AutoRun.exe” (this file is located in the root directory of the CD) program will 
automatically start running, otherwise, you need to manually run the setup program on 
the CD. 

Note: Please make sure that the dongle for EagleDot has been installed. Otherwise, the 
application will be installed as a demo version. In that case, the job output will be 
restricted to a certain size and a mark indicating it’s a demo version will be added. 

Follow the steps below to install EagleDot:  

1. If the AutoRun.exe on the installation CD runs automatically, it will display a window 
shown as follows. If it doesn’t run, double-click the setup.exe under the Installation 
folder to start the installation.  



Founder EagleDot User Guide 

 

 6 

 
Figure-2 

2. Click Setup to open the following dialog box. Choose EagleDot and then click OK. 

 
Figure-3 

3. The install program asks you to choose a setup language. It provides three language 
options: Chinese (Simplified), English, and Japanese. Choose a setup language, click 
Next to continue.  
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Figure-4 

4. The program begins to collect information that is required for installation.  

 
Figure-5 

5. When it finishes collecting information, it pops up the welcome window.  
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Figure-6 

6. Click Next, you get license agreement. Click Yes to accept all the terms and continue.  

 
Figure-7 

7. It provides a default destination location. You may click Browse to specify another. 
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Figure-8 

8. Click Next. The Select Components dialog box then appears. 

 
Figure-9 

You can double-click the “Select Drivers to Install” or click the “+” symbol to expand its 
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included options. Check the options you want to install.  

Program Files: Install all the EagleDot program files.  

Select Drivers to Install: Select at least one device driver to install. Drivers are 
available for Canon, Epson, and HP printers.  

Select Options to Install: Select to install the RIP and/or Proofing on printing paper 
option, enabling you to realize pre-RIP proof and/or proof on printing paper.  

9. Click Next to continue. If you have selected the RIP option, please input the correct 
option number. And then click Next.  

 
Figure-10 

10. And if you have selected the Proofing on printing paper option, please input the 
correct option serial number. And then click Next.  
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Figure-11 

11. The following dialog box appears, asking you to choose a program folder.  

 
Figure-12 

12. Please select a program folder and click Next, then the screen will display the “Setup 
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Status” window, showing the progress of the installation.  

 
Figure-13 

13. When the progress bar reaches 100%, it will automatically open the “Readme” file 
and the program folder. View them and close, and you will see the following window. 
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Figure-14 

14. Please determine whether you will restart your computer right now or not. And then 
click Finish to complete the installation. 

Note: For those who are using parallel port printing on Windows 2000, EagleDot Setup 
has modified ECP port to enhance printing speed. The old models of printers that does 
not support EPC mode would not print normally. In such case, you need to run 
Bin\W2KECP.EXE under the EagleDot directory, which is a tool that automatically recover 
and setup EPC mode. 

2.1.2 Uninstall EagleDot 

Before removing EagleDot, we recommend you to use Export Parameter command of 
the File menu to back up your useful data in some other place. To remove your EagleDot, 
execute the following operations: 

1. On the Windows operating system, click Start > Control Panel > Add or Remove 
Programs. 

2. Select EagleDot from the Add or Remove Programs window. 

3. Click the Change/Remove button. 

4. Then the Confirm File Deletion window appears. If you want to completely remove 
EagleDot, please select “Yes, please completely remove”. If you want to remain the 
templates and color solutions, please select “No, I would like to keep the parameter 
templates, color solution, others please remove”. And then click OK. 

 
Figure-15 

5. Then appears the Deleting Application form your Computer window, wait until all 
the checkboxes are checked, and click OK. The EagleDot is removed. 
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Figure-16 

You can also remove EagleDot by selecting Start > All Programs > Founder 
EagleDot > Uninstall. 

2.2 Update Your Dongle 

At the first time when EagleDot is delivered to you, you will be provided with two types of 
software dongles: the normal dongle and the “time limit” dongle. If you select to use the 
normal dongle, you don’t need to update it. If you select to use the “time limit” dongle, 
which can offer you two months’ time to use the EagleDot, you must update it during 
these two months, so as to extend the time limit or make it a permanently-used dongle. 
You can update your “time limit” dongle in two ways: 

The first way is to update through a .pkg file. This method can extend the time limit of 
your dongle, and also can update your dongle to a permanently-used one. You need to 
provide the dongle information and the user information to Founder, and then get back 
a .pkg file. 

The dongle information can be obtained through the Dongle Info command under the 
Help menu. This command can open the following window for you. 
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Figure-17 

You can click the Save button to save the dongle information as a .txt file. After receiving 
this .txt file, Founder will send back a .pkg file to you. When you update your dongle, 
please click the Update Dongle command under the Help menu, you will open the 
following dialog box.  

 
Figure-18 

Select the .pkg file you obtained, and then click the Open button to begin the update. If 
succeeds, the Information Window will display information like “update successfully”.  

The second way is to update through a KEY.txt file. This is the traditional method to 
update your dongle. In general, it can only extend the time limit. At first, you also need 
to provide your dongle information and your user information to Founder. The method to 
obtain the dongle information is the same as that mentioned in the first way. However, 
the user will receive a KEY.txt file instead of a .pkg file. Put the received KEY.txt file in the 
“Bin” folder under the directory where EagleDot is installed, such as “D:\Program 
Files\Founder\EagleDot\Bin\”, and then restart EagleDot, you will finish the update of 
your dongle.  

2.3 EagleDot Quick Start 

EagleDot is a post-RIP digital proof product. And it also supports pre-RIP digital proofing 
with the RIP option. In order to help you more easily use this product, we will first 
introduce you the general process of digital proofing in this section, and then provide you 
with detailed descriptions about the specific operations in the next chapters.  
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2.3.1 Post-RIP Proof 

Post-RIP proof is applied to print RIPped jobs, such as 1 bit TIFF files. To use EagleDot to 
print a RIPped job, please execute the following operations: 

Launch EagleDot 

When you have successfully installed EagleDot, you will see an “EagleDot” icon on the 
desktop. You can double-click this icon or select Start > All Programs > Founder 
EagleDot > EagleDot to launch the application.  

 
Figure-19 

Set the Unit 

When the software is launched, we recommend that you first set the unit you will be 
using in EagleDot. Select the Option menu and click Units Setting, and then select a 
unit from the three unit options Millimeter, Inch or Point.  

Create a Template 

After you have set the unit, you can proceed to set a parameter template. A parameter 
template includes all the parameter settings that you will use in the process of printing. 
Once a template has been set, you can apply the template to your future work, so as to 
avoid repeating parameter setting. To set a parameter template, follow the steps below: 

1. Open the Parameter Template(s) window 

Select Parameter Template(s) in the File menu, or click the  button in the toolbar 
to open the Parameter Template(s) window.  
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Figure-20 

This window displays the default templates provided by the system for the printers 
whose drivers have been selected by you during the installation. You can directly use, or 
modify and then use these default templates, or create your own new template. Since the 
modifications to the default templates cannot be saved as the software is being closed, 
we recommend that you create a new template.  

2. Add a parameter template 

We recommend that you create your own template based on the default template. For 
example, if you are using an Epson printer, select “Default for Epson”, and click the Add 
button. You will see the Add dialog box. 

 
Figure-21 

Enter the name of the new parameter template and click OK. Here we use the “Epson 
4800” as an example. The system then pops up the template’s parameter setup window.  

3. Select a printer 
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Figure-22 

Please select the printer you will use from the Printer(s) dropdown list. 

4. Set the Printer Setup parameters 

Click Printer Setup button to open device parameter setup window.  
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Figure-23 

As an example here, we set all the parameters except for the Port parameter to the 
default settings. Under the Port tab, select Printer Port, and then from the dropdown 
list below, select the port of your printing device. Or you may also select the IP Address 
and directly input the IP address of the printer.  

5. Set the Color Setting parameters 

Color management is an important feature in EagleDot. You can effectively manage the 
colors in any job through the Color Setting parameters. To set these parameters, click 
the Color Setting button in the template parameter setup window to open the setup 
interface.  
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Figure-24 

Here you may need to select a color calibration solution for your template. EagleDot 
provides some pre-defined and validated color calibration solutions for you to choose 
from. You can select an existing solution from the Calibration Solution dropdown list, 
or you can create a new one. After the selection, the area below the dropdown list will 
display detailed information about the selected solution. For details about how to create 
a color solution, please refer to Founder EagleDot v4.6 Color Calibration Guide.  

Please check the Proofing on printing paper option and choose a suitable scheme from 
the dropdown list behind, if you want to enable this capability. In this case, it will disable 
the calibration solution enabled above. The proofing on printing paper is an optional 
function, requiring you to provide serial number during the installation to activate.  

You may also need to select a spot color table and a color tune curve for your template. 
The Spot Color Table is used to manage the spot colors that appear in the jobs. The 
Color Tune enables you to adjust the process colors. See Chapter 4 for more details.  

Then click OK to return. 
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6. Set the Options parameters 

You may also need to set the Options parameters. Please click the Options button to 
open the Options window, where you can set the Page Setup, Transfer, Naming Rule 
and Export pdf parameters. 

 
Figure-25 

7. Set a password 

You may wish to set a password for the template. Click the Password button in the 
template parameter setup window and the Setup Password dialog box will appear: 
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Figure-26 

Input the password, and click OK to return.  

8. Save your setup 

Click OK to save the setup, or click Cancel to exit without saving. Then return to the 
Parameter Template(s) window, you will find that the newly added template “Epson 
4800” has already been added to the list of templates. 

Now we have successfully created a template “Epson 4800”. You may click Modify to 
further alter the parameters. After setup, click Close to shut down the window. For 
detailed information about how to set a Parameter Template, please refer to Chapter 3. 

Submit a Job 

To submit a job, please select Open File (RIP) in the File menu, or click the  button 
in the toolbar, and the Open dialog box will appear: 

 
Figure-27 

First, select the file type in the Files of type list. Then select a parameter template from 
the ParamTPL(s) dropdown list. EagleDot will apply your selected template to RIP and 
print the job. The Modify button on the right allows you to modify all parameters of the 
selected template. After you have chosen the template, you can select the file that you 
want to submit, and click the Open button.  

Note: The ParamTPL(s) list will not display all the parameter templates. What it 
displays is dependent on the file type you have selected from the Files of type list. 

The opened file will be submitted to the Waiting to RIP queue in the Job Monitor and 
becomes a job waiting to be RIPped. 
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Figure-28 

RIP and Print a Job 

1. RIP a job 

When a job has been submitted into the Waiting to RIP queue, you can continue to RIP 
the job. To RIP it, check the Continue Ripping box, and EagleDot will begin to RIP the 
jobs that are in Waiting status. 

 
Figure-29 

The progress bar on the right of the Continue Ripping checkbox displays the RIPping 
progress. While the job is in the course of RIPping, you may click the Abort button that 
locates between the Continue Ripping checkbox and the progress bar to abort the 
RIPping process. When the RIPping operation is completed, the RIPped jobs will all be 
moved to the Waiting to Print queue in the Job Monitor.  

2. Print a job 

When you check the Continue Print box in the Job Monitor, the jobs in the Waiting to 
RIP queue that are in the Waiting status will be printed. However, there are the 
following two possibilities: 

The first: you find the job vanished in the Job Monitor. The reason why the job seems to 
have vanished is that the General Parameters > Auto Page Position parameter in the 
printer setup window has been checked by default.  

EagleDot is able to position many small jobs on a sheet of paper to save material (Of 
course you can uncheck Auto Page Position to disable the function). Select Device 



Founder EagleDot User Guide 

 

 24 

Monitor in the View menu, or click the  button in the toolbar to open the Proof 
Device Monitor window. 

 
Figure-30 

Click the Show Buffer button, the following window appears. You can see the missing 
job is located in the ganging buffer. The window shows the relative position of the job on 
the output paper. 

 
Figure-31 

If you are satisfied with the position, you can continue to print by clicking the Output 
button, or click the Discard Buffer to cancel. 
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The second: if you have unchecked the Auto Page Position parameter in the printer 
setup window, the printer will begin to print your job directly, as shown in the following 
figure: 

 
Figure-32 

The progress bar on the right of the Continue Print checkbox displays the printing 
progress. While the progress bar is not fully completed, you may click the Abort button 
that locates between the Continue Print checkbox and the progress bar to abort the 
printing operation.  

Now you have finished the operations for printing a job.  

2.3.2 Pre-RIP Proof 

Pre-RIP proof is applied to print pre-RIP jobs, such as PDF, JPG and EPS files. The 
operating process for pre-RIP Proof is basically the same as that for post-RIP proof. The 
differences are as follows: 

Input RIP Option Key 

The ability to print a pre-RIP proof is an option in EagleDot. Therefore, you need to input 
the RIP option key to activate this function. 

If you did not input the RIP option key during the installation process, you can input the 
key after EagleDot is launched. Select Input RIP Option Key from the File menu, the 
following dialog box appears.  

 
Figure-33 

Input the correct key in the Option Key edit box and click OK.  

Set the Template Parameters 

The biggest difference between pre-RIP and post-RIP templates lies in that the EagleDot 
Template option is NOT checked for pre-RIP proof template.  
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Figure-34 

This checkbox is grayed in case that you haven’t enabled the RIP option.  

When you uncheck this box, if you can click the Options button, you can see that the 
Options parameters are also different from those in the post-RIP case.  
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Figure-35 

Submit a Job 

After you have set the parameter template, click Open File (RIP) in the File menu, or 
click the  button in the toolbar, and the Open dialog box appears. 
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Figure-36 

Click the  button on the right of the Files of type. You will find such new added files 
type options as All Files, PS Files, PDF Files, EPS Files and JPEG Files. They are the 
file types supported for pre-RIP proofing. When the file type is selected, the 
ParamTPL(s) dropdown list will be loaded with the templates that support the file type 
you have just selected. Select the template from this list, and then select the file and click 
the Open button.  

The steps for RIPping and printing a job are identical to those for post-RIP proof, please 
refer to Section 2.3.1. 

 

Congratulations! Now you have finished the installation of EagleDot and printed out your 
first digital proof job. For detailed descriptions about each operation, refer to the 
following related chapters.  
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Chapter 3 
Set a Parameter Template 
Parameter template is an aggregation of parameters that are applied in digital proofing. 
These parameters include output device name, resolution, page size, etc. In EagleDot, 
you may set many templates according to your requirements, and give them names easy 
to be remembered. At the time of job submission, select a template for the job. The 
parameters in the template will be automatically applied in the RIPping and printing, so 
as to improve your working efficiency.  

We have already described the steps of setting a template in the previous chapter. In this 
chapter, we will provide you with the details on the parameters included in a template.  

 
Figure-37 

3.1 Set the General Parameters 

In this section, we first introduce you to the parameters Template Name, Printer(s), 
Print Range, EagleDot Template and Password in the template parameter setup 
window.  

3.1.1 Parameter Template Name 

Every user-created template may have its own name. This name is displayed in the 
Parameter Template Name edit box. You can change the name. For you to better 
memorize, the template name has usually some relationship with the setting of some 
special parameter or the device model, such as Epson 4800.  

3.1.2 Printer(s) 

Choose from the Printer(s) dropdown list, the printer that will be used for printing. This 
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will affect the Printer Setup parameters, mainly because the functions of different 
output devices may vary.  

3.1.3 Print Range 

Specify the page range of a job to be printed. There are three options: 

All: To print all pages of a job. 

Pages: To print a range of pages (from one page to another page). Here you can 
manually input the page numbers.  

Custom: You can customize the pages that you want to output. The valid separators 
allowed in the Custom edit box include “,” and “-“, which mean “and” and “to” 
respectively. For example, you may input “2,5-8,17”, which means to output page 2, 
pages 5 to 8, and page 17. 

3.1.4 EagleDot Template 

If you haven’t purchased and input a RIP option key, EagleDot Template will be 
disabled. If you have purchased and input the RIP option key, this parameter will be 
activated.  

By default, the EagleDot Template is checked. When this setting is checked, EagleDot 
can only support post-RIP proofing and process such post-RIP files as Common TIFF Files, 
EagleRIP4.0 Files, EagleRIP3.0 FMP Files, 1-bit tiff from HQ Rip and TIFF/IT, Scitex CT/LW. 
If it is unchecked, EagleDot can support pre-RIP proofing and process pre-RIP files such 
as PS, PDF, EPS and JPEG Files. Therefore, for a template that has EagleDot Template 
checked and a template that has it unchecked, their supported file types are different 
from each other.  

In the template parameter setup window, the main difference between when the 
EagleDot Template option is checked and unchecked lies in the Options parameters 
and the device option General Parameters > Negative.  

3.1.5 Password 

Password protection can enhance the security of a template by preventing other users 
from modifying the template parameters. If a password has been set for a template, it 
will be required whenever you want to save modifications to the template. To set a 
password, click the Password button, and the following dialog box will appear: 

 
Figure-38 

If you have already set a password before, you may need to input the old password.  
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Input the password, and click OK to return.  

3.2 Printer Setup 

EagleDot supports printers from a wide variety of manufacturers. Depending on the 
specific functions of the printers, the parameters for you can set in EagleDot will vary. 
Click the Printer Setup button in the template setup window to open the device 
parameter setup window. 

The parameters include:  

3.2.1 General Parameters 

 
Figure-39 

Resolution: This option controls the output precision of the printer. Different printers 
may have different available resolutions. The Resolution dropdown list provides all the 
resolutions available for the current selected printer.  

Media Size: The system pre-defines many commonly-used media sizes: A1, A4, B5, etc. 
You can also select Custom from the list box to input customized width and height. 

Printable size: It refers to the size of the printable area on a page.  
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Copies: The allowable number of copies to output can range from 1 to 10,000. 

Disable jobs exceeding media size: If checked, the output of jobs that exceed the 
media size will not be allowed. And if this situation occurs, the Information Window will 
display the message “XXX (the job name) size for outputting exceeds size of paper”. If 
not checked, the Page Overlay option will be disabled and shown in gray. 

Mirror: If checked, EagleDot will output a mirror image of the file.  

Margin: The margin is the blank space bordering the printed area on a page. You can 
define this blank space by specifying the Left and Top margin options. 

Centering: There are three options: None, Horizontal and Sheet centering. If the 
output media is single page paper, you can select the Sheet centering, and the image will 
be positioned in the center of the paper; or you can select the Horizontal centering, and 
the image will be printed in the center of the left or right edge of the paper. If the output 
media is roll paper, we recommend that you select the Horizontal centering, but you can 
also select the Sheet centering. In the latter case, after a job has been printed, the next 
print would not start on a new page, but would start in the blank area below the printed 
job on the same page. 

Auto Page Position: If the job size is much smaller than the output paper, any smaller 
page of any RIP job can be automatically positioned on the output paper in a 
paper-saving layout. This function is available only for those jobs that use the same 
template and the parameters of the template must not be changed in the course of 
printing. By default, this option is checked. Once Auto Page Position is checked, you 
can define the gutter between the individual ganged pages.  

Manual Output: When you have selected the Auto Page Position option, you can 
continue to select this checkbox. If you have selected this checkbox, you may see the 
message: “Can't gang job again, please output in Device Monitor“ in the Information 
window as the printing is proceeding. This is because buffer is full of jobs and cannot 
keep on buffering the successive jobs. You can click the Show Buffer button in the 
Device Monitor window to examine the contents of the buffer. Then you must click 
Output or Discard Buffer to continue. Without the Manual Output selection, the 
buffer will automatically output the initial jobs, and gang the rest of the jobs. 

Auto Page Split: The job size may sometimes be larger than the output media size. In 
this case, you can split the job into multiple pages to print out.  

First, uncheck the Disable jobs exceeding media size option to activate this 
parameter. If you don’t select Auto Page Split option, the excess parts of the oversized 
job will not be printed. As shown in the below, only part of the job (Picture B) would be 
printed out in this instance.  
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Figure-40 

If you select the Auto Page Split option, the excess parts of the oversized job will be 
printed on new pages as shown in the following figure. The job would be split into four 
parts, and each part would be printed separately on a new page.  

 
Figure-41 

With this parameter, you can define the size of the overlapping area of split pages in X, 
Y edit boxes. X represents the size of the overlapping area of split pages in the horizontal 
direction. Y represents that size in the vertical direction. 

Negative: If checked, the output will be negative. However in practice, if the job 
submitted is a post-RIP negative file, the output result will be positive when this 
parameter is checked. Only when the EagleDot Template is checked will this parameter 
appear under the General Parameters tab.  

Advanced: Click this button and an Advanced parameters setup window will pop up.  

3.2.2 Advanced Parameters 

The Advanced Parameters panes vary as the functions of various printers differ.  
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1) Most Epson printers 

 
Figure-42 

Ink Type: The type of the ink, Pigment or Dye. 

Black Ink Type: The type of the black ink, PhotoK or MatteK. 

Paper Source: The mode for feeding paper, Roll, Sheet or Paper Tray. 

Media Type: The type of the output media, such as Plain Paper, Coated Paper, 
Glossy Paper and Synthetic Paper, etc.  

Paper Suction: The intensity for paper suction, the value varies according to the type 
and thickness of the output paper.  

Auto Cut: If checked, printer will automatically cut after printing the paper.  

Nozzle Check: If checked, printer outputs a built-in image pattern. By observation, you 
can find out if the nozzle is clogged.  

Bi-Directional Print: If checked, the printer head prints when moving in both directions, 
so as to get a higher printing speed. In general, we recommend you to uncheck this 
parameter, because it may result in quality degradation.  

Borderless: If checked, borderless printing will be enabled.  

Feed Paper Adjustment parameters 

Some Epson devices support you to manually adjust the speed of feeding paper, so as to 
avoid irregular lines of ink traces on the paper as a result of too fast or too slow feeding 
speed. The Feed Paper Adjustment parameters are activated only when the device 
itself supports this capacity.  

Print Block: The number of the strips that will be printed, the range is from 1 to 16. Each 
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strip is a pattern appearing as follows.  

 
Figure-43 

Print Minimum: The minimum speed level. The range is from 1 to 201. 

Print Maximum: The maximum speed level. The range is from 1 to 201 as well.  

Print Point: EagleDot uses 201 print points, sequentially from 1 to 201, to represent the 
levels of feeding speed. 1 represents the slowest speed level and 201 the fastest.  

E.g., if you set Print Block to 5, Print Minimum to 1 and Print Maximum to 201, then 
there will be 5 levels below Print Point, 1, 51, 101, 151 and 201. If you change Print 
Minimum to 80 and Print Maximum to 100, the levels turn to 80, 85, 90, 95 and 100. 
The smaller the difference between Print Minimum and Print Maximum, the smaller 
the difference between any two speed levels, and thus the more accurate the final speed 
level will be.  

Tip: Experience shows that at the very beginning you can set Print Minimum and Print 
Maximum within the range of 80~140 and Print Block to 6.  

Best Adjustment: The best speed level. You need to manually input the value after 
observing the printed strips.  

Print: Click it to print out the strips when you have configured the settings above.  

After the print, check if there are horizontal gaps on the strip, in the appearance of blank 
or color bands. A presence of blank gaps indicates that the speed is too high, while color 
gaps indicate that the speed is too slow. If no gap appears, continue to check if each color 
block is fine and uniform. Choose the speed level that produces a strip with fine and 
uniform color blocks and without gaps.  

Result from improper speed (gaps appear obviously): 

 
Figure-44 

Result from proper speed (no gaps, and color blocks are all fine and uniform): 

 
Figure-45 

Note: If you can't decide the best speed level at the first time, you can lower the Print 
Maximum and Print Minimum values appropriately, then print and observe once 
again. 
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2) HP printers 

 
Figure-46 

Print Pass: Print pass has a close relationship with the quality and speed of printing. 
Greater print pass will generate a higher quality print, but will lower the printing speed. 
Less print pass gets higher speed but lower printing quality.  

Note: If Print Pass is set to 1, the options Print Speed and Bi-Directional Print will 
be disabled. Change its value, these parameters will be activated. 

Print Speed: In the dropdown list, you will see the following options for printing speed, 
Fastest, Fast, Normal, Slow and Slowest. Generally speaking, higher speed 
generates lower quality while lower speed generates higher quality.  

For other parameters, please see the related descriptions above.  

3) CanoniPF printers 

 
Figure-47 
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Automatic Cutting: If you choose Yes, printer will automatically cut the output paper 
after printing. If you choose Print Cut Guideline, the printer will print the cut guideline. 

Unidirectional Print: Having this option checked, unidirectional printing is carried out; 
having this option unchecked, bidirectional printing is carried out. 

3.2.3 Port 

Please specify here the printing device actually used for the proof.  

 
Figure-48 

Printer Port: If checked, you can specify the printer to be used by way of the printer 
port. By clicking the Properties button on the right, you can configure the specified 
printer’s properties.  

IP Address: If checked, you can input directly the IP address of the printer. 

Print to File: If you need to print the job to a file, check this option. 

Path: You can determine the path where the printed job will be saved. The default path 
would be “…:\Program Files\Founder\EagleDot\Temp\”. You can click the Browse button 
to specify another path.  

File: The File edit box allows you to specify the name of the printed file. By default, the 
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file name is PrintFile*.prn. When multiple jobs are printed, a number is added to each 
file name, for example, PrintFile.prn, PrintFile1.prn, PrintFile2.prn… 

Use Default File Name: If checked, the printed file name takes the stem of the source 
file name, and the extension is .prn, e.g. a source file name is sample.tif, checking this 
option ensures that the printed file name is sample.prn. 

3.2.4 Print Comment 

 
Figure-49 

Print Comment(s): If checked, the selected comment will be printed on the lower-left 
corner of the output paper. If not unchecked, the comment options below will be grayed.  

Printing start time: If checked, the output time of the job will be printed on the paper. 
The time format is: Year\Month\Date\ Hour\Minute\Second.  

Job Name: If checked, the name of the job will be printed on the output paper. 

Color Solution Info: If checked, the information about the color solution used will be 
printed on the output paper. 

Color Tune Info: If checked, the path of the color tune curve will be printed on output 
paper. 
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Attached Info: The additional information except those comments mentioned above. 
You can input this additional information in the right column. 

Print ColorBar: EagleDot can print a color bar to help you assess the print quality. If 
checked, you can choose a color bar file by the Browse button, and the chosen color bar 
file will be printed both on the upper and lower areas of the output paper. The default 
“…:\Program Files\Founder\EagleDot\Resource\Control Strip\ColorBar.tif” is a standard 
TIFF file.  

We recommend you to check the with Color Management option. When checked, 
EagleDot will apply color management to print the color bar. As for the Only one copy & 
Autocenter option, if checked, only one copy of the color bar will be printed, and located 
on the center of media width. If not checked, multiple copies of the color bar will be 
printed to fit the job width. 

Notes: If the Auto Page Position parameter is enabled, the color bar will be printed on 
the upper and lower of the imposed page instead of each job. If the paper size is not big 
enough to print the color bar, the system will automatically cancel to print the color bar. 
And the Information Window will display the message: “xxx (job name) size for 
outputting exceeds size of paper.” 

3.2.5 Halftone 
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Figure-50 

The Halftone tab is displayed and activated only when the EagleDot Template option 
is unchecked (i.e. pre-RIP proof) and the color parameter Advanced > Color Mode is 
set to 4. The parameters underneath are used for you to define the screen setting.  

Dot Shape: shape of the dots, EagleDot provides 10 dot shapes, Round, Ellipse, Rhomb, 
Diamond, Square, Quick FM, Pure Round, Sharp Ellipse, Cross, and FM.  

Frequency: The number of lines per inch, sometimes also called density of dots. Higher 
value enables smaller dots and thus higher image quality, but may possibly results in dot 
enlargement. In practice, its value is closely relevant to the resolution, media and ink 
type.  

Angle: Proper screen angles can effectively minimize the moirés occurred in full-color 
image printing. Each separation may have a specific angle. There are generally four 
angles 15°, 45°, 75° and 90°. You can change the angle as needed.  

Halftone levels: The level of grayness, affected by resolution, frequency, and even the 
computer memory. Generally, the higher the level, the better the image detail is 
reproduced, especially the gradient.  

3.2.6 Border 
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Figure-51 

Under the Border tab you can perform two operations: to define a border and to define 
a bleed. In practice, the border will be usually used to simulate the CTP output, so as to 
have an idea about where exactly a job will be located on the CTP plate. In this case, a 
border can be added to a job as the virtual CTP plate.  

The Bleed edit box allows you to input a bleed value. The Width and Height edit boxes 
of the Border/Bleed allow you to input the width and height values of a border or bleed 
(when the two values are larger than the job size, they become the width and height for 
a border; when they are smaller than the job size, they become the width and height for 
a bleed). The Color refers to the color of the border or bleed lines, and the Thick is their 
thickness. The value range for the Thick is 0~2 mm. The Media Size refers to the size 
of the output media, which is determined by the Media Size parameter under the 
General Parameters tab. The Printable Size refers to the size of printable area on the 
current media, the remaining Media Size being deducted by a default blank margin. And 
the Job Size refers to the actual size of a job.  

When the Border pane is opened while you are creating a template, due to that there is 
not an available job size, the Job Size and Placement parameters, as you can see in the 
figure above, will be disabled. At this time, if you want to define a bleed, you can directly 
input a value in the Bleed edit box. Note that the valid value is no more than 10 mm. You 
can also directly input a width and a height to define a border based on the Printable 
Size. Note that the input values cannot be larger than the printable size. Because you 
don’t know the actual job size, the input values may also become the width and height for 
a bleed. The placements for both the border and bleed will be centered by default. 

If you want to more precisely define a bleed or border according to the actual job size, 
please use the following method to open the Border pane: 

Return to the Waiting to Print queue in the Job Monitor, right-click a job that has been 
RIPped, and select Print Setup in the pop-up menu to open the printer setup window. 
Click the Border tab to open the Border pane: 
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Figure-52 

At this time, the job size is displayed and the placement parameters are enabled.  

1) To define a border: 

Please input a width and a height, and make sure that the size of border is within the 
range of the printable size. Here as an example, we input 251.42 and 200.62 (the job size 
is 231.42*180.62). Then, determine the Placement. By default, the job position is 
Center. But you can select Manual to customize the top, bottom, left or right gutter 
space between the job and border. And then you can also specify the color and thickness 
of the border. The defined border can be previewed at the lower part of the pane. 
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Figure-53 

Note: When the Auto Page Position is enabled, if you have defined a border, each 
ganged job on a page will have a border printed.  

2) To define a bleed (cut lines): 

The operations are similar to those for defining a border. But note that the bleed size 
must be smaller than the job size. As an example, we input 211.42 and 160.62. The 
result is shown as follows: 
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Figure-54 

Note: When the border is smaller than the job, the color of the border turns to red, 
showing the bleed. And the gutter space values are negative. 
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3.3 Color Setting 

3.3.1 General 

 
Figure-55 

1) Calibration Solution 

Click the triangle  button below Calibration Solution, and you will see a broad range 
of color calibration solutions. These solutions are automatically provided in EagleDot, and 
are designed to be used for color management. You can directly use these existing 
solutions, or create a new color calibration solution on your own by using the color 
solution tool. For details about how to create a color calibration solution, see the 
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independent Founder EagleDot v4.52 Color Calibration Guide.  

When you have selected an appropriate color calibration solution, the information about 
the selected solution will be shown below the dropdown list. 

 
Figure-56 

The information includes the setup data for such color-related parameters as Resolution, 
Color Mode, Screen Mode, Ink Type, Black Ink Type, etc. When the color calibration 
solution is selected, this data will automatically override the corresponding parameter 
setups. At this time, the corresponding color-related parameters, such as Resolution, 
Color Mode, Screen Mode, Ink Type, Media Type, will be displayed in gray.  

Note: If you haven’t chosen a solution for current template, then when you use the 
template to print files, the information window would display message such as “Please 
select calibration solution first”. In such case, please choose a proper calibration solution 
here in advance.  

2) Proofing on printing paper 

You need to provide serial number during the installation before you want to use this 
option. Being enabled, this option will disable the color calibration solution setting.  

If checked, you can use printing paper, instead of the special paper employed in digital 
proof, to do your digital proof. When checked, please choose a suitable paper option from 
the dropdown list behind. Other settings are the same as normal digital proof. By using 
printing paper to proof, you can lower your proof cost significantly without sacrificing the 
color quality.  

3) Spot Color Setting 

Spot Color Table: A spot color table is composed of spot colors. When the system is 
RIPping a job, if the job being RIPped contains spot colors, the system can identify the 
spot colors and will add them to the selected table in the template. When printing, the 
system will utilize the spot colors added to print the spot color separations. Therefore, a 
spot color table can be viewed as a platform to store the spot colors of the jobs. Please 
select a spot color table from the dropdown list on the right, from where you can use the 
default spot color table provided by the system, or the spot color table created on your 
own through the Spot Color Editor.  

The spot colors in the spot color table can be modified through the Spot Color Editor. 
When modifying spot colors, there are two possibilities. One is to create a new 
user-defined spot color through the Spot Color Editor. The user-created spot colors can 
be applied through the Color Replace function and the Substitute Spot Color in Spot 
Color Table option. The other is to modify the spot colors in the jobs. After the spot 
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colors of a job are accessed by the system, i.e. after a job has been RIPped by the system, 
please open the selected spot color table of the template through the Spot Color Editor. 
If the system was not able to access its color values, such as its CMYK or LAB values, the 
user has to input these values manually through the editor. If the system is able to access 
its color values, the user may also need to modify these values according to the actual 
demands.  

Please note that only the composite files can provide the detailed spot color information, 
such as the spot color names, CMYK or LAB values. Therefore the system can access the 
detailed spot color information of a composite file. With other file types that do not 
contain this information, the system may only be able to access the spot color names.  

Substitute Spot Color in Spot Color Table: If the name of a spot color in the job is the 
same as that of a spot color already existing in the spot color table before the job is 
RIPped, when this box is checked, the system will substitute the spot color in the job for 
the spot color in the spot color table.  

4) Color Tune 

Color Tune curve: The dropdown list on the right provides the color tune curves for you 
to select. They can be created through the Color Tune tool, see Section 4.2 for details.  

5) Paper White Simulation 

The paper for digital proof may be much whiter than the paper used for press printing. 
This will inevitably affect the digital proof which simulates the effect of the press. In such 
case, you can select this checkbox, and the blank area on the proof paper will be slightly 
screened, so as to simulate the appearance of press paper. 

After you select a color calibration solution and check the Paper White Simulation box, 
a WhitePoint Editor area will appear, where you may edit the paper white simulation 
values.  

 
Figure-57 

Note: If the color calibration solution you select is created with the help of a manual color 
calibration wizard, then Paper White Simulation will be grayed out. If the render intent 
you select when creating the solution is Perceptual, Relative, or Saturation, Paper 
White Simulation option will be unchecked and shown in gray; if the render intent you 
select is Absolute, Paper White Simulation option will be checked and the 
WhitePoint Editor area below will show the paper white simulation values. 

There are two rows of values for CMYK separations: Original and ChangeValue. The 
original values of the paper white simulation in the color calibration solution selected are 
displayed in the first row of boxes and cannot be changed. You may specify a number 
ranging from -4 to +4 into each of the four corresponding boxes in the second row. Note 
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that the values you input are difference values. The actual simulated paper white values 
are the original CMYK values plus the values you input. The range of number you may 
input into these boxes may vary a little, as the simulated paper white values are not 
allowed to be below 0. For example, if the original value is 0, you may only enter 0~4.  

The rectangle on the right shows the comparison between the original simulated paper 
white and the one with changed value. The upper left part represents the original one, 
and the lower right part represents the changed one. 

6) Retain Black 

When this option is selected, the system will directly use black ink to print the Pure Black 
process color. The ink type of the printer can be a factor for you to determine this 
parameter. Here we will use an Epson printer as an example. There are two ink types for 
Epson printers, PhotoK and MatteK. If the ink type is MatteK, you may check this 
option. If it is PhotoK, which has a color cast, it’s recommended that you uncheck it.  

Range: The range of the pure black color that the Retain Black applies to. You can input 
a value from 1 to 100. For example, if you input 50, the Retain Black will apply to the 
range from 50 to 100. 
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3.3.2 Advanced 

 
Figure-58 

1) Color Replace 

Color Replace enables you to replace any of the C, M, Y, K process colors with your 
selected color. In the window shown above, each C, M, Y or K color separation has a 
dropdown list, from where you can select a target color. For example, you can select 
Magenta to replace Cyan. 
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Figure-59 

You may use a spot color to replace one or more of these four process colors, but you 
need to first select under General tab a spot color table with spot colors defined in the 
Spot Color Editor. The defined spot colors in the selected spot color table will be loaded 
into the dropdown list on the right of each process colors.  

Notes: You cannot use Color Replace to replace spot color separations. You may use 
Spot Color Editor to modify spot color values. You cannot replace the colors with the 
same process color. For example, you cannot use Yellow to replace Cyan, and continue 
to use Yellow to replace Magenta.  

2) Composite 

The Composite parameter enables you to print partial color separations of a job. 

1. When the Composite option is checked, EagleDot will print out the selected color 
separations below the Composite option, and output all the selected separations in a 
single file. By default, the Composite option and all the colors below, including the four 
process colors and the spot color, will be selected. This is because we usually need to 
print out all the color separations of a job. However, you may want to print partial color 
separations. To do this you must uncheck the unwanted color separations. The following 
images show an example of partial color printing: 

 
Figure-60 

Picture A is an image that completely combines the CMYK process colors. If you want to 
only print the C and M colors, please check Cyan and Magenta below the Composite 
option, save the template, and then apply the template to print. The printed result will be 
the same as Picture B.  

2. When the Composite option is not checked, EagleDot will also print out the selected 
color separations below the Composite option, but output more than one files, with each 
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file displaying only one single color. For the example above, if you check Cyan and 
Magenta, and meanwhile don’t check the Composite option, the printed result will be 
two images, see Picture C and Picture D in the following figure. 

 
Figure-61 

Now we take a practical example and combine with other functionalities to describe the 
specific operations. In practice, you may need to continuously print out a single C, a 
composite CM, a composite CMY and a composite CMYK color separation files as in the 
following figure. In this case, what shall you do?  

 
Figure-62 

You can view them as 4 individual jobs and follow the printing process to print out 
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respectively. Or you can simplify the operations by following the steps shown here: 

1) Create or set a parameter template. For the Composite parameter, use the default 
setting.  

2) Switch to the Job Monitor, use the template to open a file and check Continue 
Ripping to RIP it. Then the job appears in the Waiting to Print queue.  

3) Right-click the job and choose Color Setting from the pop-up shortcut menu. The 
Color Setting window will appear. In this window, click the Advanced tab and you will 
see the Composite parameter. Now you can change the setting. Please check the 
Composite option and choose only Cyan, then click OK to return to the Job Monitor.  

4) Check Continue Print to print the job. When the job is printed out, the job will be 
listed in the Printed Job queue.  

5) Uncheck Continue Print, then select the job in the Printed Job queue and click the 
 button in the toolbar. The job will be moved to the Continue to Print queue.  

6) Repeat Step 3 to change the settings of the Composite parameter. At this time, 
please check Composite, choose Cyan and Magenta together. And then repeat Step 4 
to print out the second job.  

7) Repeat Step 6 for two times to print out respectively the third and fourth jobs. When 
you print the third job, please check Composite, and choose Cyan, Magenta and 
Yellow. When you print the fourth job, please check Composite, and choose Cyan, 
Magenta, Yellow and Black. 

If your job size is small enough for auto ganging, we recommend you to enable the Auto 
Page Position function to save your paper, the steps are as follows:  

1) Create or set a parameter template. Check the Auto Page Position option under the 
Printer Setup > General Parameters tab. As to the Composite parameter, please use 
the default setting.  

2) Switch to the Job Monitor, use the template to open the job and check Continue 
Ripping to RIP it. Then the job appears in the Waiting to Print queue.  

3) Right-click the job and choose Color Setting from the pop-up shortcut menu. Then 
the Color Setting window appears. In this window, click the Advanced tab and you will 
see the Composite parameter. Now you can change its setting. Please check Composite 
and choose only Cyan, then click OK to return to the Job Monitor. 

4) Right-click the job again and choose Re-RIP from the pop-up shortcut menu. The job 
will be re-RIPped. The re-RIPped job will also be listed in the Waiting to Print queue.  

5) Repeat Step 3 to change the setting of the Composite parameter. And then repeat 
Step 4 to re-RIP another job.  

6) Repeat Step 5 for two times to RIP the next two jobs.  

7) When you have finished the setup of the Composite parameters for these four jobs in 
the Waiting to Print queue, check Continue Print to print. Because you have enabled 
the auto ganging function, the system will first move these jobs into the buffer before the 
print. Please click the  button to open Device Monitor. Continue to click the Show 
Buffer button, you will find that EagleDot has already automatically ganged these jobs. 

Note: You cannot gang two jobs that use the same template but one has the spot color 
option under the Composite checkbox selected and the other has it unselected.  
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3) Gray and Black Only 

Gray: If checked, all color separations will be transferred to Gray in output and the 
Composite parameter will be disabled and shown in gray.  

Black Only: If checked, all color separations will be replaced with Black.  

4) Color Mode and Screen Mode 

Color Mode: The color modes supported by the current printer. If you have not specified 
a color calibration solution previously, this parameter will be available for you to select. 

 
Figure-63 

You need to select a value for this parameter when you create a color calibration solution. 

Screen Mode: If no color calibration solution is selected under General tab, Screen 
Mode parameter is editable. There are three options in the dropdown list: FM1, FM2, 
and FM3. If a color calibration solution has been selected, the screen mode that is used 
in the solution will be shown here. FM1 or FM3 is recommended for users who would like 
to do Pre-RIP proofing. For users who would like to do post-RIP proofing, FM2 or FM3 is 
recommended.  

You need to select a value for this parameter when you create a color calibration solution. 

5) Selective Color 

The optional color proof allows you to replace the original color with destination color in 
output. With this parameter, you can realize optional color calibration, which refers to the 
replacement of original color with destination color on the image. 

The following steps show you how to use the Selective Color function: 

Open the configuration window of Selective Color 

1. Start EagleDot. Open the file and RIP it. 

2. After RIPping, bitmap file is generated and go to Waiting to Print queue. 

3. Right-click the file in the queue and select Color Setting in the pop-up menu. 

4. Check Selective Color under the Advanced tab and the Setting button is activated.  

5. Click the Setting button.  
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Figure-64 

In this table, you can establish one or more color replacement relations. If a certain color 
has been appointed a destination color in the table, the original color will be replaced by 
the destination color when processing files. 

6. To realize the selective color calibration, you need to add such color calibration or 
replacement relation. Click the Add button to get the Add Color dialog box.  

 
Figure-65 

You should first define the original and destination colors for the replacement.  

Define the Original and Destination colors 
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In the window as shown above, the upper-left part is the preview area of the job, the 
lower-left and right is the operating area. The square color blocks on the right just show 
the original and destination colors. The Original color refers to the color you want to 
replace. It can be defined by inputting specific CMYK values, or can be selected by 
clicking anywhere on the previewed image. The Destination color refers to the color you 
use to replace the Original color. It can be defined by inputting specific CMYK values, or 
can be selected by clicking anywhere on the previewed image as well. And you can also 
define it by manually adjusting the Hue, Saturation and Intensity values in the below. 
The valid range for the input CMYK values is 1-100. The Hue, Saturation and Intensity 
can be adjusted by sliding corresponding buttons or by inputting numbers manually.  

The Ink values after the Destination parameter refer to the actual ink amount in print. 
It is calculated with the related data of your selected color calibration solution. The deltaE 
value in the below represents the color difference between the Original and 
Destination colors.  

Set the Ratio parameter 

The Ratio parameter is designed for you to adjust the color range for the calibration or 
substitution. The higher the value, the wider range of the color will be replaced. To set 
this parameter, please click the Gray Preview option to get the window shown as in the 
below. The Ratio edit box will then be activated for you to input a value.  

 
Figure-66 

As you can see, there are some white areas in the previewed figure. They are just the 
places that will be replaced by the Destination color. And they will be enlarged as the 
Ratio value increases. Please input a Ratio value according to your actual demand.  

Global and Local calibrations 

You may need to replace the selected color only in a specific area of the figure. In this 
case, you need to check the Rectangle box. If you check it, we call the replacement as 
local calibration. If you don’t check it, the system will replace the selected color in the 
whole figure. We call the latter global calibration.  

By default, the Rectangle box is unchecked. If we still take the figure above as example, 
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this means that all the white areas in the figure will be replaced by the destination color. 
If you click the Preview option, you will see the following result. 

 
Figure-67 

If the Rectangle box is checked, you may draw a rectangle on the image, see the 
following figure. In this case, only the color within the rectangle will be replaced.  

 
Figure-68 

Now you have finished the configuration of a color replacement. Please click OK, the 
corresponding data will be added to the Pick Color table. 
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Figure-69 

In the Pick Color dialog box, you may click Add to add another color replacement 
relationship, or click Edit or Delete to edit or delete a selected color replacement. 

When you have finished the setup, you can save the whole set of color replacements as 
a *.stc file by the Save As button. Or you can load an existing *.stc by the Load button. 

6) Adjust Ink Hue 

The Ink Hue control can ensure that the ink hue in digital proof is consistent with that of 
press standard.  

Open the parameter template, choose Color Setting > Advanced > Change InkHue > 
Setting, to open the Ink Hue setup window.  
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Figure-70 

In the upmost-left edit box, you can input the value of dot percentage at which you need 
to adjust the ink hue. And then, select B Spline or Straight in the right list. The chart in 
the upper-right part of the window will show the adjusted ink status with the selected 
curve type. And the two color squares show respectively the color appearance before 
adjustment and that after the adjustment. 

Now let’s adjust the hue of each process color ink. If you want to change the hue of cyan 
ink, select the Cyan tab, and check the boxes of other inks that you want to add to the 
cyan ink. Here we take Magenta and Yellow as examples. When you check the Magenta 
and Yellow ink options, a sliding block will appear under each of the color strips on the 
right. Drag the sliding block, the value shown in the edit box next to the color strip will 
change accordingly. This value stands for the percentage of the added ink. You may also 
enter the desired value directly to the edit box.  

If you are satisfied with the ink hue adjustment, you can click the Save As button to save 
the current settings as a file with the extension of “.inh”. Or you can click the Load button 
to load an existing “*.inh” file. The Reset button allows you to reset all changes to 
default status. Select the end point of a curve, and click the Delete button, the curve of 
the selected color will be deleted. 

Click OK to complete the ink hue adjustment.  

3.4 Options 

The Options parameter works differently for post-RIP proof and pre-RIP proof. In the 



Chapter 3 Set a Parameter Template 

 

 59 

template’s parameter setup window, when the EagleDot Template option is checked, if 
you click Options, you can define parameters for post-RIP proof; when you uncheck the 
option, you can click Options to define those for pre-RIP proof.   

3.4.1 For Post-RIP Proof 

 
Figure-71 

Note: If you use the default templates of EagleDot, the Naming Rule pane will be 
missing when you open the Options window.  

1) Page Setup 

Rotate: With an aim to facilitate bitmap ganging, this function can be used to determine 
the direction in which a job is printed on the paper. The default is No Rotation. The four 
options of No Rotation, Rotate 90 degree, Rotate 180 degree and Rotate 270 
degree control the image direction on the output paper. If you select Rotate 90 degree, 
the image will be rotated 90 degree counter-clockwise. Similarly, if you select No 
Rotation, the image will not be rotated.  

Scale: The scale can be adjusted in both the X direction and Y direction. 100% indicates 
that the output image size is the same as the actual page size. If both boxes say 80%, 
the image will be scaled 80% in both the X and Y direction. 200% indicates that the 
output size is two times the actual size. The default is 100%.  

Fit in Page Size: If checked, the image will be scaled to a proper size to fit the page and 
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the scale percentage is disabled.  

Preview: There are two options, Fast and Accurate. Fast implies that the jobs can be 
viewed more quickly but lower at quality, while Accurate implies a slower load time but 
a higher image quality.  

Descreening: There are four options for descreening: smooth1, smooth2, smooth3 
and smooth4. Smooth1 enables a lowest level of descreening and the dot shape can be 
best preserved. Smooth4 enables a highest level of descreening and the dot shape may 
be lost most heavily. Smooth2 and smooth3 is in the middle of them. By default, the 
Descreening is set to smooth1.  

Clear moiré pattern: This option is used to clear off the unacceptable moiré patterns 
appeared on some separations (if any). It can reduce moiré patterns, but may result in 
some loss in dot shape at the same time. If there are moiré patterns on some separations, 
please select the separations under Clear moiré pattern, and then print out again. If 
moiré patterns still exist, you need to select smooth3 or smooth4, and meanwhile, select 
the separations under Clear moiré pattern.  

Note: If the output resolution is set to 1440*1440dpi, generally speaking, you need only 
to use default settings to print out a job. There is little difference in output result when 
you use 1440*720dpi and 720*720dpi respectively to print. But if you select smooth3 or 
smooth4, or if you select the separations with moiré patterns before you print, the dot 
shape will be lost quite heavily. 

2) Transfer 

Transfer is used for compensating the linearization applied in RIP products. To meet some 
requirements in the back-end output environment, some RIPs may use linearization 
curves while generating 1 bit TIFF files. When processing such a 1 bit TIFF file, EagleDot 
utilizes this transfer tool to represent the original linear effect of the 1 bit TIFF file. 
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Figure-72 

The values of the transfer curve should be completely the same as that of the 
linearization curve used in the RIP settings.  

You can input the data directly into the corresponding edit boxes. Or you can also click 
the Load button to load a curve file. The Linear button allows you to reset all the values 
in the edit boxes. The Save button is used to save current linearization data. 

The setups of the Input Curve Directly checkbox and the color separation name 
correspond to the settings of the linearization curve in the RIP.  

3) Naming Rule 

When submitting a job that contains more than one color separations, such as 1 bit TIFF, 
either by normal operational process or by hot folder, EagleDot is able to automatically 
identify the C, M, Y, K separations and spot color separations of the same job. A user only 
needs to define the naming rule for the separations, and system will automatically detect 
CMYK and spot separation files by the naming rule.  
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Figure-73 

Set a simple naming rule 

As shown in the above figure, input key words for C, M, Y, K dialogue boxes respectively 
in the Input Naming Rule area to identify their corresponding separation file names. 
For example, if you input character C in the Cyan dialogue box, EagleDot will identify all 
separation file names that contain character C as Cyan when you submit your job. After 
you input a key word, click Add button and a simple naming rule is set. The new naming 
rule can be seen from the Naming Rule List below, where the default naming rules 
provided by EagleDot are also listed. Note that you may delete your self-defined naming 
rules, but not these default naming rules.  

Use Extended Naming Rule 

The naming rule mentioned above enables EagleDot to support 1 bit tiff files generated 
by various RIPs in a simple way. However, there are some cases, in which it does not work 
well. For example, with this naming rule, EagleDot cannot support some of the TIFF files 
when there is only one separation of CMYK, or the combination of only one separation 
with spot color separation(s), or the combination of only spot separations. Extended 
naming rule, which is able to define more flexible and complicated naming rules, copes 
very well with the disadvantages of this situation.  

Select the checkbox Use Extended Naming Rule to view the interface. EagleDot 
provides two default extended naming rules with the name of Default and 
name_rule_1. The two default extended naming rules are listed in the Naming Rule 
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List box. You may directly use or edit them, or create a new one. 

To create a new naming rule, you can click Auto Create button to open the following 
dialog box. Input a name and key words for C, M, Y, K or click the  button to specify 
corresponding color separation files, and click OK, you will quickly create a new naming 
rule. 

 
Figure-74 

Or you can click the New button to open the Extended Naming Rule window as shown 
in the following figure to create a naming rule: 

 
Figure-75 
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There are the following four steps to define a naming rule. The settings of each step are 
displayed respectively in the above four tabs: <1>Files, <2>Separator, 
<3>Group_Plate and <4>Display. 

Now let’s see an example, in which the target tiff file name is in the pattern of 
“girl_P1_C.TIF”, “girl_P1_M.TIF”,“girl_P1_Y.TIF” and “girl_P1_K.TIF”. 

<1>Files 

First define conditions that target files meet. The system provides two conditions in the 
table. Here we will use them as an example.  

However, you can specify a condition on your own. From the two dropdown lists below, 
select two conditions respectively, for example, “ignore files” and “beginning with”, then 
input the characters “SSS” in the right edit box. That is to say, the naming rule will ignore 
files beginning with “SSS”. Click the Add button, the edited condition will be added to the 
table above.  

 
Figure-76 

Note: If the added conditions include both types of “include files…” and “ignore files…”, 
the target files need to meet both of the two types of conditions. Whereas, if there are 
only includes or only ignores, the relationship between each condition is OR instead of 
AND. 

The edit boxes at the bottom of the window allow you to define the minimum and 
maximum filename length. 

<2>Separator 

Now let’s go to the second step. Click the Separator tab, and the following interface will 
be displayed. 
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Figure-77 

This step allows you to separate a file name into parts with your specified separators.  

First, let’s define the first part. Input a name you prefer in the Part Name field, here we 
take Part A as an example. Next, select “any character”, “numbers only” or “specific 
words” in Part Contains dropdown list. Then select a separator in Separator dropdown 
list, for example “to ‘_’ (underscore) separator”. If “to separator” is selected, you can 
type in a character as the separator. Click the Add button to add the part into the list.  

Then, we repeat this process to define the other parts as needed. According to the 
pattern of the target tiff file names mentioned above, “girl_P1_C.TIF”, etc, we need to 
define three parts, separated by “_”, “_”and “.” respectively. See the following figure. The 
first target tiff file name “girl_P1_C.TIF” for example is separated into three parts: “girl”, 
“P1” and “C”. 
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Figure-78 

If Case Sensitive Matches is selected, you need to pay attention to the case of the 
specified separators or characters. If the Read From Right box is checked, you need to 
define the file name parts from right to left. If With Current Separator is checked, the 
specified separators will be included in the file name. 

<3>Group_Plate 

Select the Group_Plate tab to open the following setting interface. 
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Figure-79 

EagleDot will group all the CMYK or spot color plates of the target file into one complete 
tiff file while submitting jobs. Therefore, two problems exist: 

First, what plate files will EagleDot regard as separations of one common tiff file? The 
Group Files With Part(s) edit box below Job Grouping does this grouping work. For 
example, if we select Part A and Part B at the same time, it means all files that are 
identical in these two parts will be treated as separations of a file. In our example, all file 
names that contain “girl_P1” are separations of the same tiff file. 

Next, what color plates do these files represent respectively? To identify different color 
plates, select a part from the dropdown list of Plates Part below Plate Identification. 
Here we select Part C, which means characters in Part C determine what color plate a file 
represent. See the table below the Plates Part dropdown list. If the character in Part C 
of the target tiff file name is C, the color plate is Cyan. Similarly M stands for Magenta, 
Y stands for Yellow, and K stands for Black. You may also use the IN edit box and the 
OUT dropdown list to define your own way of plate identification. The target tiff files that 
go beyond the CMYK color plates will be automatically identified as spot color plates by 
EagleDot.  

Case Sensitive Mapping 

If Case Sensitive Mapping is checked, you need to pay attention to the case of the 
characters. 

<4>Display 

Select the Display tab to open the following figure. The settings under this tab allow you 
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to decide which parts will be displayed in the file name. 

 
Figure-80 

In the figure above, if we select Part A and Part B, the final target tiff file that contains all 
separation files will display only Part A and Part B of its file name. In our example, the 
parts displayed are “girl” and “P1”.  

Note: Generally, we don’t select to display the part that stands for color plates. 

In the Jobname String field, you can change the display order of the parts, or add any 
characters. The added characters will appear in the file name. 

Click OK and a Save As dialogue box will appear to allow you to save the newly created 
extended naming rule.  

Input the name of the naming rule, for example “NewRule”, and click Save to return to 
the Options window. The newly established naming rule “NewRule” now appears in the 
Naming Rule List box. To use it, you need to first select it, and then click the  
button to move it to the Naming Rule Selected box.  
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Figure-81 

With the naming rule, EagleDot will identify and group all tiff files that fit. In our example, 
all four tiff color plate files will be grouped as one file. See the following figure: 
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Figure-82 

4) Export pdf 

You may export RIPped bitmaps to a specified location as PDF files and view them 
independently. The following figure shows the interface of the Export pdf pane. Note 
that this function is available only when you have provided correct key number.  

 
Figure-83 

Check Export Pdf box in the above window and select a location to store the exported 
PDF files by clicking Browse button behind the pdf path edit box. You may specify a 
network path. The default path is …:\Program Files\Founder\EagleDot\PreviewPdf. The 
exported PDF files will be named as “job name+job ID+page number”, for example, 
“Baseline.tif_00000006_0001.pdf”. 

Another way to export PDF files is by right-clicking jobs in the Waiting to Print or 
Printed Job queue and selecting Export pdf command.   



Chapter 3 Set a Parameter Template 

 

 71 

3.4.2 For Pre-RIP Proof 

 
Figure-84 

1) Page Setup 

The settings under Page Setup are mainly about RIP setup. 

Rotate: With an aim to facilitate bitmap ganging, this function can be used to determine 
the direction in which a job is printed on the paper. The default is No Rotation. The four 
options of No Rotation, Rotate 90 degree, Rotate 180 degree and Rotate 270 
degree control the image direction on the output paper. If you selected Rotate 90 
degree, the image will be rotated 90 degree counter-clockwise. 

Scale: The scale can be adjusted in both the X direction and Y direction. 100% indicates 
that the output image size is the same as the actual page size. If both boxes say 80%, 
the image will be scaled 80% in both the X and Y direction. 200% indicates that the 
output size is two times the actual size. The default is 100%. 

Fit in Page Size: if this option is checked, the image will be scaled to a proper size to fit 
the page and the scale percentage is disabled. 

Preview: There are two options, Fast and Accurate. Fast implies that the jobs can be 
viewed more quickly but lower at quality, while Accurate implies a slower load time but 
a higher image quality. 

Ignore Absent Font and Image File: In practice, you may encounter absent fonts, or 
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even absent image. For example, a customer may provide you with a PS file, some fonts 
of which are not included in EagleDot. If Ignore Absent Font and Image File is 
checked, when absent fonts or images occur, EagleDot will ignore absent fonts or images 
while processing the file. The position of the absent font will be replaced by a default 
substitute font, and absent image positions will be blank. If the box is not checked, when 
absent font or image occurs, the system will report an error and abort the process of the 
job. The absent font will be displayed in the Information Window. At this moment, you 
can use the Font Substitution Table provided in EagleDot to specify a substitute font. 
Please refer to Section 7.2.3 for more details. As for how to process absent images, 
please refer to the options Ignore Image File Path and Default Image Path. 

Note: If the PS file is generated by Founder layout applications such as Founder Fit and 
Founder Book Maker, the absent fonts and images in the PS will be ignored by Founder 
EagleDot. You need to check this option.  

Ignore Image File Path: Some users of layout applications use an absolute image path 
in PS files, which follows the rule of “computer name\path\file name”. When the PS is 
delivered to another location to be processed, the program would still attempt to locate 
the image file by the original image path, which actually does not exist any longer. In 
EagleDot, we have an Ignore Image File Path option. When this option is checked, the 
absolute image path will be ignored and EagleDot will only browse the path of the PS and 
the paths described in parameter template, so as to improve the browsing efficiency. 

Stroke Adjust: If a job is output at a low resolution, the effect of the rules, strokes and 
table lines in the file may not be satisfactory. If Stroke Adjust is checked, the thickness 
and position of lines will be improved. 

Override Stroke In Job: If checked, system uses the default stroke setting of EagleDot. 
If not, system adopts the stroke setting in job defined with layout application.  

Override OverPrint In Job: If checked, EagleDot will use the setting in OverPrint 
Type option instead of the setting in layout application. If the option is unchecked, the 
OverPrint Type option will be replaced with Black Only, and meanwhile, the 
parameters Override OPM In Job and Nonzero Overprint will be activated.  

OverPrint Type: If you check Override Overprint In Job, EagleDot uses the overprint 
setting specified here instead of that defined in the file. The Overprint option allows you 
to print an element of one color over one of another color without removing, or knocking 
out, the material underneath. The Black Only option enables only the 100% black 
elements to be overprinted, it is the default option. The Knockout option enables all the 
separations to be knocked-out. White gaps may appear due to inaccurate alignment. 

Override OPM in job: If checked, any OPM parameter in the job is ignored. If it is not 
checked, any OPM parameter in the job will be used. By default, this option is selected. 
This option is available only when Override Overprint In Job option is not selected. 

Nonzero Overprint: By default, this option is not available. It becomes available when 
OverPrint in Overprint Mode dropdown list is selected, or the Override Overprint In 
Job option is not selected. Nonzero Overprint option is applied to the case when two 
colors overlap, the upper one has any one or more of its C, M, Y, K separations set to a 
color value of zero. In this case, if you check Nonzero Overprint, the two colors will be 
overprinted; if you don’t check it, the lower color will be knocked out instead of being 
overprinted. For example, we assume that the CMYK values of the upper color are all set 
to zero, i.e., the upper color becomes white. If Nonzero Overprint is checked, the upper 
white color will disappear, for that it will be overprinted with the lower color. If not 
checked, the white color will knock out the lower color.  
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Use Idiom Substitution: If checked, EagleDot uses PostScript Level 3 smooth gradient 
description to replace the old smooth gradient description in PS. PostScript Level 3 
employs new smooth gradient dictionary and operators to describe smooth gradient, 
greatly improving the speed and quality of generating smooth gradient, and supports 
more types of smooth gradient, for you to easily generate colorful smooth gradient 
graphics. 

Support Level1 SpotColor: If checked, EagleDot will better support the smooth 
shading of spot color defined in layout application.  

Enable Spot Color Output: By default, this option is checked, spot color separations 
will be output as separate color plates when being RIPped. If it is not checked, spot color 
separations will be converted and output into the process color separations. 

Print copies in file: Jobs often specify their own number of copies to be printed. If you 
want EagleDot to print the specified number of copies of a job, just check the Print 
copies in file box. If the checkbox is not selected, the number of copies specified in the 
job will not take effect.  

Thickness: If checked, the thickness of the text objects in your job will become thinner 
after the RIP.  

Default Image Path: In Default Image Path, you may enter more than one path. 
Different paths should be separated by “;”. Such as: “C:\EagleDot\IMAGE; 
D:\USER2\IMAGE”. EagleDot will locate the image file from the paths one by one. 
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2) Register Mark 

 
Figure-85 

Enable Mark: If checked, register mark will be added to the output page. If not, the 
register mark will not be added.  

Mark Type: EagleDot currently offers 15 types of registration marks: Cross Mark, Solid 
Circle, Internal CutLine, External CutLine, Folding Line, Book Spine, Anti Cross, Rect 
Mark, Square Mark, Circle Mark, L Cross, U Cross, Corner Mark, Hollow Circle and 
T-shape. 

Position: The marks can be positioned at the following positions on the page: the 
Corner refers to the four corners of the page; the Edge refers to four positions close to 
the four corners on the left and right sides; the Top refers to four positions close to the 
four corners on the top and bottom sides; the Middle refers to the middle of the four 
sides; and the Top Middle refers to four positions close to the middles of the top and 
bottom sides. Click Select to add the selected mark on the selected positions, while click 
Unselect to discard the added mark.  

Mark Size: Here you can specify the size of mark and the thickness of the mark line. 

Center Offset: Distance from the mark to the top, bottom, left or right edge of the page.  

Line Offset: The horizontal and vertical distance between cut lines. This option is only 
available for Internal CutLine or External CutLine. 
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Include File info: If checked, the path name of the current file will be printed on the top 
of the page. The option is not selected as default. 

Include Color Bar: If checked, color bar will be printed on the area out of the print area 
on a page. As default, the option is not checked. 

Include Current time: If checked, the output time will be added to the top of the page. 
As default, the option is not checked. 

Comment: If checked, you can input comment in the edit box, and the comment will 
appear at the bottom or on the edge of a page. 

Font: It allows the user to select the font that the comments will be printed with. 

Attached Info Pos: This option decides the position of the attached information, such 
as file information, color bar, current time and comment, which can be arranged on the 
Top, Bottom, Left and Right of the page. If there are no special requirements, the 
Default position is recommended.  

When you have completed the above settings, click OK, the settings will be applied to the 
output file. If you click the Reset button, all the settings will be reset to default settings. 

3) Other 

 
Figure-86 

Page BoundingBox: EagleDot identifies the size determined by your specified page box 
as the page size. Page boxes in a PDF file may include Media Box, Crop Box, Bleed Box, 
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Trim Box and Art Box. E.g. suppose there are two page boxes defined in the PDF page, 
Crop Box size is A4 (210x297mm), Bleed Box size is 200x287mm (bleed 5mm, so the 
size is smaller), if you choose Crop Box here, the page size of the generated PDF page 
would be 210x297mm, but if you choose Bleed Box, the page size changes to 
200x287mm.  

PDF PassWord: If the submitted PDF file contains password, you must provide the 
password here so that EagleDot can correctly process the file. The Adobe Acrobat allows 
you to set two passwords in a PDF file: Open Password controls permission to open the 
file; and Permissions Password controls the permission to edit.  

1) The PDF file contains no password: No password is required in PDF PassWord edit 
box.  

2) It contains only Open Password: You must provide the correct Open Password.  

3) It contains only Permissions Password: If the PDF file allows to be printed, you do 
NOT need to enter the password. If the PDF allows NOT to be printed, you must provide 
the correct Permissions Password.  

4) It contains both Open Password and Permissions Password: If the PDF file allows 
to be printed, you need to provide only one password. If the PDF allows NOT to be printed, 
you must provide the correct Permissions Password.  

Use the icc in PDF: You can select to use the ICC in the PDF. 

Pipe Print Template: Check this option if you want to set the current template as a 
network pipe print template.  

RGB Image ICC Source File: By default, this box is unchecked. When it is unchecked, 
the jobs in RGB mode would be converted into CMYK mode by applying some fixed 
algorithm in the Pre-RIP core. If it is checked, you can select another ICC profile to 
perform this conversion to realize the anticipated result.  

4) Export pdf 

See Section 3.4.1. 
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Chapter 4 
Color Management 
4.1 Spot Color Editor 

The Spot Color Editor is developed to ensure that spot colors in your jobs are correctly 
processed. This section can help you use this tool to create and manage spot colors. 

4.1.1 Introduction 

As opposed to a mix of CMYK inks which make up process printing, a spot color is a 
specially mixed ink that is applied on the printing press. For this reason spot colors can be 
produced in a much more vibrant range of colors than can be created from mixing 
process colors. More and more spot colors are being applied today in the printing industry. 
For example, corporate colors, golden, silver and other metallic ink colors are printed 
with spot colors.  

Instead of using spot color inks to represent spot colors, EagleDot adapted the color 
gamut of the digital proofing device, which is larger than that of a CMYK press, to 
compose spot colors. The Spot Color Editor tool is the tool provided in EagleDot to create 
effective representations of spot colors.  

The Spot Color Editor manages spot colors in spot color tables. Before spot colors in print 
jobs can be output as spot colors, they must first be defined in the Spot Color Editor and 
saved in a spot color table. Then when you create or modify a parameter template to 
print jobs, if you select the spot color table, those spot colors will be automatically 
processed.  

4.1.2 Create a spot color table 

Click the Spot Color button  in the toolbar to open the Spot Color Table window: 

 
Figure-87 
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EagleDot provides a default spot color table, which can be directly used and modified by 
the user. To create a new table, click the Add button to open the Add dialog box. 

 
Figure-88 

Input a valid name, and click OK.  

 
Figure-89 
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In this window, you can define and edit spot colors (see the sections following). When 
you have finished the configuration, you can click OK to save the spot color table, and the 
table will be added to the Spot Color Table.  

 
Figure-90 

Now we have finished the creation of a spot color table. In the Spot Color Table window, 
you can select a spot color table and click Modify button to further modify it. Or you can 
click the Delete button to delete it. Note that the default table cannot be deleted. 

4.1.3 Modify a spot color table 

To modify a spot color table, open the Spot Color Table window and double-click the 
spot color table you want to modify, or select the spot color table and click Modify button, 
then the Spot Color Editor window will be opened.  

1) Spot Color lists 

First, let’s get to know the spot color lists in this window. The upper-left corner of the 
window is an area of spot color lists. The top displays the name of spot color table, and 
in the below are three spot color lists: Spot Color In Current Job, Custom Spot Color 
and System Spot Color. 

 
Figure-91 

Spot Color In Current Job: The spot colors existing in current job. To view them, switch 
to the job monitor, right-click the RIPped job in the Waiting to Print queue and choose 
Show Spot Color Table to open the Spot Color Editor window. In this window, 
double-click Spot Color In Current Job or click the “+” symbol in front, and you will see 
the spot colors in the current job (if any).  

Custom Spot Color: All customized spot colors, may contain the spot colors 
newly-created or modified by the user and the spot colors found in the course of RIPping. 
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System Spot Color: The unchangeable spot colors provided by system. You can click 
the Load button at the bottom of the window to load these system spot colors into 
current spot color table. 

System Spot Color First: This checkbox is located at the lower-left corner of the Spot 
Color Editor window. When it is selected, if two spot colors in the spot color lists have a 
same name, the spot color in the System Spot Color list will be used first. Otherwise the 
system will use the spot color in the Custom Spot Color list first. By default, this box is 
unchecked. 

2) Define a spot color 

You can define a spot color by performing the following steps: 

1, Input a spot color name in the Spot Color Name edit box. 

 
Figure-92 

2, Input the CMYK or LAB values. The color will be displayed in the color block on the 
right.  

3, Click the Add button to save. 

Click the Add button in the lower left corner of the window to save the spot color.  

Note that whenever you want to save a setup or modification to a spot color, you must 
click the Add button. Moreover, if the name is the same as some spot color that already 
exists in the table, the system will display a dialog box to ask for your confirming.  

Now you have simply defined a spot color, if you want to further manage or adjust the 
color of your spot color, proceed with the following section. 

3) Adjust the color of a spot color 

1, Select a color range 
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Figure-93 

EagleDot provides two Color Range options, Source and Device color ranges. 

When you want to use the color gamut of press to represent spot colors, select the 
Source color range. When you want to use the spot color ink to represent spot colors, 
whose color gamut is larger than that of press, please select Device color range. This is 
because that the device color range is usually larger than that of press as well. By default, 
the color range is set to Source. 

2, Input the Opacity percentage 

The Opacity parameter describes the overlap relationship between the upper and lower 
color layers. To set this parameter, input directly the value in the edit box and click the 
Add button. The default value is 0.  

Different opacity values enable different transparency effects. For example, if you input 
0, you can get the overprint effect. If you input 100, you can get the knockout effect. If 
you input a value between o and 100, e.g. 70, the upper layer will have a 70% covering 
effect on the lower layer, i.e. the 100% of the upper layer and the 30% of the lower layer 
will overlap. See the following figure.  

a. When the greenish spot color is considered as the upper layer and its opacity value is 
set to 0, i.e. the overprint effect: 
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Figure-94 

b. When its opacity value is set to 100, i.e. the knockout effect:  

 
Figure-95 

c. When the opacity value is set to 70, i.e. 70% greenish color and 30% orangey color: 

 
Figure-96 

Note: The selection of the OverPrint Type for the Override Overprint in Job option 
may affect the opacity effect.  

3, Adjust the Color Tune curve for spot colors 
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Figure-97 

The Color Tune curve for spot colors is a fine adjustment tool. The users can adjust this 
curve as their experience dictates. By default, this curve is an oblique line in 45-degree 
slope. To adjust it, put the cursor at any point of the curve, then click and drag. If you are 
not satisfied with the adjustment, you can click Reset to restore the default value. When 
you have adjusted the curve, please click Add to save.  

The following two figures illustrate the differences when different curves have been used.  

a. When the original curve (i.e. oblique line in 45-degree slope) has been applied to the 
two spot colors of the job (Spot1 and Spot2):  
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Figure-98 

b. When the adjusted curve has been applied to the spot color Spot2 (the orange one): 

 
Figure-99 

Global Curve: This is a curve applied to all the spot colors in a spot color table. To set 
this type of curve, first select the spot color table name at the upper left corner of the 
window, and then adjust the curve and click Add to save it.  

 
Figure-100 

At this time, if you want to apply a different curve to one of the spot colors in the table, 
please select the spot color first, and then adjust the curve and click Add to save it. The 
separately adjusted curve has priority over the global curve.  

4) Edit a spot color 

Delete a spot color 

You can delete a spot color by selecting it and clicking Delete button. 

Find a spot color 

Click Find button to open the Find dialog box. 
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Figure-101 

When you input a spot color name and click OK, the system will start to search for the 
color in the table. Note that each Find operation can only find and display one spot color 
for you, in case that two spot colors in the table have the same name, you need to 
perform the Find operation again to find the other spot color.  

4.1.4 How to use spot color table 

To use a spot color table, please switch to the Color Setting window of a parameter 
template and select the spot color table you want to use.  

 
Figure-102 
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When using the template to RIP a file that contains spot colors, EagleDot can access 
some information about the attributes of the spot colors. This information can be seen in 
the Information Window.  

 
Figure-103 

However, there are two possibilities. If the RIPped file is a composite file, the detailed 
attributes of the spot colors such as the name and the color values are provided, 
EagleDot can access all these data. If it is a separation file, this detailed data is not 
provided, EagleDot may only read the spot color name and cannot access the 
corresponding color values.  

In general, the accessed spot colors in the RIPped job will be added to the spot color table. 
But if a spot color that has the same name already exists in the spot color table before 
RIPping, will the accessed spot color be added to the table as well and replace the 
existing one? In this case, it depends on whether you have selected the Substitute Spot 
Color In Spot Color Table checkbox in the Color Setting window of your parameter 
template. By default, this box is unchecked. If you want to use the spot color that has the 
same name in the current job, you can check this box. But when you have checked this 
box, please note that the existing spot color will be replaced, and next time when you 
read another spot color that has the same name, the spot color in the table will be 
replaced by the spot color in the job once again.  

4.2 Color Tune 

In some cases you may find one or more printed colors are not printing to your 
satisfaction, or the printed result is pretty good, but your customer may specially ask you 
to increase or reduce the density of some colors. The Color Tune tool within EagleDot is 
used for this purpose. 

The Color Tune tool can be used to tune or adjust any or all of the four basic process 
colors by applying a color tune curve to realize the adjustment. The color tune curve can 
be created or modified through the Color Tune tool for process colors provided in 
EagleDot. Open the Color Tune tool to create a curve. And then, when you have created 
a curve, you can open the Color Setting window of the parameter template and find the 
Color Tune parameter, select the curve to apply it. 

To create a color tune curve, please perform the following steps: 

1. Click the Curve button  in the toolbar to open the Curve List window: 
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Figure-104 

2. In this window, you can click the Add button to add a new curve if it is the first time 
opening it. If there are already some curves in this window, you can select a curve and 
click Modify to modify it, or click Delete to remove it. Here we click Add to open the Add 
dialog box shown as follows: 

 
Figure-105 

3. Input a valid name and click OK. The color tune curve window will appear. 
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Figure-106 

Click the Zoom In/Zoom Out button  or  on the upper-left corner of the window, 
and the view of the window will be enlarged or reduced.  

4. In the dropdown list at the top, select the color separation(s) from CMYK, Cyan, 
Magenta, Yellow and Black. Then you can adjust the color tune curve for the selected 
process color(s). If you select CMYK, you can adjust the CMYK-composite effect.  

To adjust a curve, you can drag any point on the curve with your mouse. When dragging 
the curve, values in the right part of the window change accordingly. You can also directly 
input the value in the edit box after a percentage value. 

When you have finished the adjustment, select View All from the dropdown list, and the 
curve section will show the curves’ appearance of all separations. See the following 
figure: 
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Figure-107 

5. After setup, click OK to save the color tune curve.  

The Undo button is used to undo the most recent one action. If you are not satisfied with 
the setup, you may just click the Reset button to reset the current curve to the original 
oblique line. 

4.3 Color Tools 

EagleDot also provides other color-related tools, including spot color tool, delta E tool, 
and the re-calibration tool.  

Click the toolbar icon  to start the color tools.  

 
Figure-108 
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Please choose the color calibration solution that you want to re-calibrate, and a template 
that can be used in the calibration. The parameter settings of the template must be fit for 
the color solution.  

Click OK, and you will see a tool list.  

 
Figure-109 

4.3.1 Spot color tool 

 
Figure-110 

The template you have chosen may be specified with a spot color table. Here you can 
modify the spot colors contained in this table or make calibration toward them. The spot 
color calibration is often performed when color inconsistence occurs after you have used 
the color solution and the spot color table in your actual work for a period of time.  
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1) Modify spot color 

Choose a spot color, and then you can directly change its properties at the right 
parameter setup area. The property parameters include color range, opacity, color values, 
and the curve (may be in two modes).  

Click Add when you finish the modification.  

2) Refine spot color 

You can make the spot color calibration by way of “print and measure” operation.  

The Refine Type parameter becomes activated when the currently-selected spot color is 
in LAB mode. Choose a type (Quick or Accurate) and then click Refine.  

Quick Refinement 

 
Figure-111 

In the Quick type, only the measuring device Eye-One is supported.  

The Target LAB are the spot color values originally defined in the spot color table. If you 
didn’t choose any spot color before you enter into the refinement window, the target 
values would all be zero, and in this case, you can click the Measure Target button 
below to measure an unknown spot color.  

Click Print to print out a single color block of the currently-selected spot color. And then 
click Measure to measure the printed spot color block. After the measurement, both the 
measured color values and the color difference compared with the target values will be 
listed at the left table.  

You can repeat the “print and measure” operation till you are satisfied with the color 
difference or the color difference rebounds. And then, choose the best result from the left 
table, and click OK.  

Return to the interface of the spot color tool. You will see that the spot color values have 
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been now updated as per the result of the refinement. Click Finish to save and exit.  

Note: due to that the final lab values are from internal calculation, the Lab values shown 
in the spot color table after the refinement may be different from those displayed in the 
refinement window.  

Accurate Refinement 

 
Figure-112 

Click Print to print out a color chart for the currently-selected spot color.  

 
Figure-113 

Click Measure to measure the printed color chart. After the measurement, you can see 
the measured color values of these color blocks and their color differences against the 
target values, from the left table. The color blocks are sorted by the color differences. The 
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color block with least color difference will be selected by default.  

Choose that color block and then you can repeat the “print and measure” operation till 
you are satisfied with the color difference or the color difference rebounds. And then, 
choose the best result from the left table, and click OK.  

4.3.2 Re-Calibration 

By way of re-calibrating the color solution created with the calibration wizard, you can 
correct the unfavorable influence on the color quality resulted from variance in proof 
environment or device state.  

In re-calibration, the measuring device is determined by the color calibration solution.  

There could be two re-calibration modes: quick calibration and entire calibration.  

 
Figure-114 

1) Quick Calibration 

This calibration requires that the current solution contains the linearization target data, 
which can be created in the second step of the calibration wizard Device Linearization. As 
the name implies, it is a quick re-calibration that needs no repetition of the “print and 
measure” operation.  

Click Quick Calibration. The user interface for this re-calibration is shown as follows.  
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Figure-115 

Click Print to print out the linearization chart. And then click Measure to measure the 
printed chart. After the measurement, click Finish.  

The data within the color solution will then be updated.  

2) Entire Calibration 

This calibration requires that the current solution contains the calibration target data, 
which can be created in the fourth step of the calibration wizard Device Calibration.  
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Figure-116 

Click Print to print out the color chart, and then click Measure to measure the printed 
result. Click Init Loop Print after the measurement.  

A new chart will be printed out after you click Init Loop Print. Please click Measure 
Create to measure the printed chart, and click Loop Print after that measurement. Now 
you get a color difference value and a newer printed color chart.  

Repeat this operation till you are satisfied with the color difference.  

Click Finish to update the color calibration solution.  

Note: You can choose only one of the two calibration modes each time. And in entire 
calibration, the color difference appears only when you finish the measurement twice. 

4.3.3 Delta E 

This tool enables you to measure the color similarity of two patterns that are same but 
printed separately under different environments. The similarity is represented by delta E 
values. The lower the delta E values, the greater the similarity is; and vice versa. The 
delta E values are calculated from the measured Lab values of the two printed patterns.  

As to the two different environments, in general, they refer to the device and the press 
environments. But they may also refer to two different circumstances of one same 
environment, e.g. a proof environment, where you apply different settings inconsistently 
at two times. Therefore, in practice, DeltaE can be used for many purposes, for example, 
to measure the color similarity between the current proof sample and the press one.  
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1) Open the DeltaE tool 

Select Start > All Programs > Founder EagleDot > DeltaE to open the Founder 
DeltaE window: 

 
Figure-117 

This window is mainly composed of three areas: a sheet on the left, which will list the Lab 
values of the two patterns and the calculated delta E values; a display area on the right, 
which symbolically displays the processed results; the operating area on the bottom, 
which contains all the command buttons needed.  

2) Select a pattern 

Click Select TIF button to load the Open dialog box.  



Chapter 4 Color Management 

 

 97 

 
Figure-118 

The DeltaE tool supports the patterns with certain specifications. These patterns are 
generally the TIF files that consist of color blocks. Here we take a pattern named 
“Founder_cmyk.tif” as an example. It is also a color block pattern.  

 
Figure-119 

Choose the file and click Open to load it into the DeltaE window.  
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Figure-120 

The color blocks of the file Founder_cmyk.tif are listed in the Block column in a line by 
line manner. At its right, there are six columns named as Ideal L, Ideal a, Ideal b and 
Actual L, Actual a, Actual b, used to record the lab values of the two printed patterns. You 
can specify the lab values of any pattern as the ideal l, a, b values, or as the actual l, a, 
b values. Note that when the lab values of one pattern are specified as the Ideal L, a, b 
values, those of the other pattern will be naturally viewed as the Actual L, a, b values.  

Both the ideal and actual lab values can be gained by way of measurement or calculation. 
Now we introduce them separately. 

3) Measure the Lab values 

Make sure the device is correctly connected before you begin the measurement. There 
are two Measure buttons in the window. You can click either of them to begin.  

The measuring window appears after the Measure button is clicked:  
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Figure-121 

First you need to choose a measuring device, e.g. Eye-One, and then, click Measure to 
start the measuring. The steps are similar to those for you to create a color solution by 
way of the color calibration wizard: before the measurement, you need also a white point 
calibration, and then when succeeds, it displays the prompt “Please measure the strip 1”. 
Put the attached plastic soleplate on the strip and Eye-One on the plastic soleplate, then 
press and hold the operating button on the device. After a sound prompt is issued, slide 
the device from left to right in regular speed to measure. And release the button till you 
get to the right end. If succeeds, it prompts you to measure the second strip, till you 
finish all of the rest strips and see the prompt “Measured successfully! Press here to 
continue”. Click it to return to the main window.  
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Figure-122 

EagleDot will note down the measured LAB values as the Actual L, a, and b values.  

Refer to the method above to continue the measurement of the ideal l, a, b values. Or you 
can refer to the following introduction, to invoke ICC to calculate the ideal lab values. 

4) Invoke ICC to calculate Lab 

You may invoke an ICC profile to calculate the lab values. There are two Open buttons in 
the window. You can click any of them to calculate the ideal or actual lab values.  

A dialog box then pops up. In this dialog box, choose the ICC profile you want to use, and 
open it, and EagleDot will then apply the profile to calculate the lab values.  

5) Calculate the delta E values 

When you have gained all the Lab values, click Calculate to compute the delta E values.  
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Figure-123 

The results are displayed in the delta E column. Meanwhile, the Color Range diagram 
and the Conclusion table in the below shows relevant statistical results. Before or after 
the calculation, you can choose another formula from the Formula list, and the delta E 
and statistical results change accordingly in real time.  

6) View the Processed results 

1. Color Range diagram 

This diagram visualizes the color similarity between the two patterns on the background 
of the Lab color space. In the diagram, the closer the two curves are to each other, the 
greater the similarity is. If the Coordinates option is checked, the coordinates will be 
shown on the diagram. X-axis represents the “a” in Lab; y-axis represents the “b”. 
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Figure-124 

2. Conclusion table 

This table displays some delta E values of importance, such as the delta Es of the primary 
C, M, Y, K, Paper White, and the Max and Mean delta Es.  

The Category column shows the names of these delta Es. The Check for column lists 
the check thresholds pre-defined for each item. These thresholds can be re-defined. The 
delta E column displays the corresponding delta E values. And the Result column 
displays whether these delta E values are under the check thresholds. If a delta E value 
is below a check threshold, it indicates with a tick mark , otherwise a cross .  

 
Figure-125 

The Parameter Setting button enables you to re-define the Check for values. 
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Figure-126 

Click Default to restore the default setting. Click OK to save and exit.  

7) Input and output reports 

When you have finished the measurement and comparison, you can output the measured 
and processed results as a report that consists of a .txt file and a .jpg file. Click Output 
Report to open a Save As dialog box. Choose or create a folder and specify the report 
name, and then click Save. Switch to the folder where you just chose or created, you will 
find two files named as specified, one is a .txt file, the other is a .jpg image, which 
separately record the results shown as in the DeltaE window.  

You can also import a report into the DeltaE window. Click Input Report, and in the 
follow-up dialog box choose the report you want to import, and then click Open.  
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Chapter 5 Print 
5.1 Operations in Job Monitor 

We have briefly described the printing operations in Job Monitor in Section 2.3. In this 
section, we will introduce you in details the operations after the job has been submitted 
into the job monitor. 

5.1.1 Operations in the Waiting to RIP queue 

In order to comprehensively introduce all the operations, we will open more than one job 
as an example. See the following figure. If you don’t check the Continue Ripping box, 
the opened jobs will all be listed in the Waiting to RIP queue. 

 
Figure-127 

The Waiting to RIP column displays the job names. The number in the bracket behind 
indicates the number of the jobs in the Waiting to RIP queue. The Status column 
displays the status of each job. There are three status states: Waiting, Hold and Error. 
An “<X>” mark will appear before the filename of an Error job. When you check the 
Continue Ripping box, the jobs that are in the Waiting status will be RIPped. The jobs 
whose status is either Hold or Error will not be RIPped.  

Learn information about the job 

Double-click a job or right-click and choose About, you will open up the About The Job 
window. As you can see, this window displays detailed information related to the selected 
job, including Job ID, template name, file name, status, separation information, etc.  
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Figure-128 

Preview a job 

Right-click a job and choose View, and you can open a window to preview the job.  

 
Figure-129 
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After you have opened this window, you can choose Bitmap Display or right-click 
anywhere on the window to get a menu. The functions of these commands are as follows:  

About: This command enables you to learn information about a job.  

Zoom In and Zoom Out: To zoom in and zoom out the bitmap.  

Fit in Window: To automatically adjust the preview window to a suitable size for the job.  

Refresh: This command can restore to the original Bitmap Display window. 

Rotate: This command can rotate the displayed job. 

Previous Page and Next Page: When a job that contains more than one page is opened, 
you can use these two commands to switch among the pages. 

Close and Close All: These two commands can enable you to close the displayed Bitmap 
Display window or windows.  

Close the window and return to the job monitor, a “<V>” mark will be added to the front 
of the filename of the previewed job.  

Re-preview a job 

When you have previewed a job and found the result unsatisfactory, you may need to 
re-define the template parameters by right-clicking the job, selecting and executing the 
Show Spot Color Table or Config Parameters commands from the pop-up menu. 
After you have re-defined the job parameters, you can right-click the job and select the 
Re-preview command from the pop-up menu to preview it once again.  

Show the spot color table 

Right-click a job and select the Show Spot Color Table command from the pop-up 
menu, and you will open the Spot Color Editor window. If EagleDot finds out undefined 
spot colors in job, it would record them into the spot color table. At this time, you can 
define these spot colors in the spot color table, so that EagleDot can correctly RIP and 
print these colors.  

Configure the template parameters 

If you need to configure or re-configure some template parameters of a job, you can 
right-click the job and choose Config Parameters to open the template parameter 
setup window, and then you can configure the parameters as needed. Note that the 
modification will only apply to the current job.  

Delete one or all jobs 

To delete a job, select it and press Delete key or right-click it and choose Delete.  

Then the screen will display a dialog box to query you as to whether to continue this 
operation or not. Click Yes and the job will be deleted. To delete all the jobs in the 
Waiting to RIP queue, right-click any job in that queue, and choose Delete All.  

Hold and Re-RIP a job 

You can hold a job, and the held job will not be RIPped when Continue Ripping is 
checked. To hold a job, right-click the job and choose Hold, and the status of the job will 
turn to Hold. To cancel the Hold status, right-click the held job and choose Release Job.  

You can also Re-RIP an abnormal job. In Waiting to RIP queue, “abnormal” means the 
Error status. If you want to Re-RIP an Error job, restoring its status to Waiting, please 
right-click the job and choose Re-RIP. To restore all abnormal jobs’ status to Waiting, 
please choose Re-RIP all abnormal jobs.  
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Change the job sequence 

You can move any job up or down in the queue. Right-click a job to open the pop-up 
menu, you can see four commands to perform such an operation: Move Up, Move 
Down, Move First and Move Last. The Move Up or Move Down command can move 
a job to the upper or latter place of the queue. The Move First or Move Last command 
can move a job to the first or last place of the queue. The buttons  and  in the 
toolbar can also used to change the job sequence, they are equal to the Move Up and the 
Move Down commands respectively.  

5.1.2 RIPping a job 

Check the Continue Ripping box, the Waiting jobs in the Waiting to RIP queue will be 
RIPped.  

The Abort button and the progress bar are both activated. The progress bar displays the 
RIPping progress of each separation of a job. The Abort button enables you to abort the 
RIPping process. When you click the Abort button as the RIPping operation is proceeding, 
a warning message will pop up. Click Yes and the RIPping process will be aborted. The 
job then returns to the Waiting to Ripping queue and its status turns to Error.  

5.1.3 Operations in the Waiting to Print queue 

When the RIPping process is completed, the job will be moved to the Waiting to Print 
queue, see the following figure.  

 
Figure-130 

The Waiting to Print queue provides information about the job names, page size, 
template name and the status. The Waiting to Print column lists the job names, and the 
number in the bracket behind it indicates the number of the jobs. Note that there is a 
number in front of each job name. It indicates the ordinal page number of a job. If a job 
contains 4 pages, there would be 4 pages numbered 1 to 4 in order. The Page Size 
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column and the Template Name columns respectively list the page size and the 
template name of the job. The Status column displays the status of each job. There are 
two status states: Waiting and Hold. When you check the Continue Print box, the jobs 
that are in the Waiting status will be printed. The jobs whose status is Hold will not be 
printed.  

You may perform some similar operations to the jobs in the Waiting to Print queue that 
may be performed to the jobs in the Waiting to RIP queue, such as showing the job 
information, previewing job, showing spot color table, configuring template parameters, 
holding a job, changing the job sequence, and etc. Some functions may be different.  

Configuring template parameters 

You can configure the Printer Setup and part of the Color Setting parameters. 
Right-click the job and choose Printer Setup or Color Setting, you will open the 
corresponding windows to configure these parameters. In the printer setup window, note 
that you can configure the Border parameters at this time, see Section 3.2.6 for more 
information. In the Color Setting window, you will find the calibration solution 
parameters are grayed out, meaning that they cannot be modified.  

Preview a job 

You can also right-click the job and choose View to preview a job. But before you perform 
this operation, you can set the display size of the job. To set this size, please choose the 
Re-preview command and select Small, or Medium, or Large command.  

Export pdf 

You can export RIPped bitmaps as PDF files for remote proofing. Right-click a bitmap 
page and choose Export pdf, then choose one of the three sizes “small, medium, large”, 
the following window will be displayed. 

 
Figure-131 

Specify a path and a name, and click Save. The RIPped bitmap page will be exported as 
a PDF file to the specified location. 
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Hold and Release a job 

You can hold a job, and the held job will not be printed as Continue Print is checked. To 
hold a job, right-click the job and choose Hold, and the status of the job will turn to Hold. 

If you want to restore the status of a held job to Waiting, please right-click the held job, 
choose Release Job. You can even restore the status of all held jobs to the Waiting 
status by choosing Redo all abnormal jobs.  

Re-RIP a job 

Right-click the job and choose Re-RIP, and the selected job will be copied to the 
Waiting to RIP queue, where you can RIP it once again.  

In addition to these similar operations, you may also perform another comparatively new 
operation to the jobs in the Waiting to Print queue. 

Move one or all jobs to the Printed Jobs queue 

You may move one or more, or even all jobs from the Waiting to Print queue to the 
Printed Jobs queue. To perform this operation, please right-click the job and choose 
Move to Printed Jobs or Move all to Printed Jobs, or use the  button in the 
toolbar.  

5.1.4 Printing a job 

You can check the Continue Print box to print the Waiting jobs, refer to Section 2.3.1 
for details. 

5.1.5 Operations in the Printed Jobs queue 

The operations to the jobs in the Printed Jobs queue are basically the same as the 
operations described in Section 5.1.3. The difference lies in that you may re-print one or 
all abnormal jobs, including the jobs that are in the Cancel or Error statuses. 

5.2 How to Print from PC on Network 

EagleDot supports not only output on a local computer, but also network printing from 
both PC and Mac computers. After setup of a parameter template, you can define the 
digital proofing device as a network printer. 

Note: You can perform network printing from PC and Mac computers only when pre-RIP 
proof is enabled (the RIP option is activated and the EagleDot Template checkbox in 
the template parameter setup window is not selected).  

EagleDot enables network-printing from PC by the help of a Pipe. Similar with the 
parameter template, you need to create a pipe first.  

5.2.1 Create a Pipe 

1. Select or create a Pre-RIP template for pipe printing. Here we will use the template 
named Epson 4800 as an example. 

2. Open the Parameter Template window, select the template “Epson 4800” and click the 
Modify button. Then click the Options button in template parameter setup window, the 
Options window will appear, see the following figure. Please click the Other tab, find and 
check Pipe Print Template, and save the template. 
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Figure-132 

Select the Pipe Print Template checkbox and save the template.  

Note: EagleDot supports multiple templates pipe printing.  

3. Select Printers and Faxes in the Start menu of Windows. The Printer and Faxes 
window appears: 
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Figure-133 

4. Click Add a printer. The following window appears: 

 
Figure-134 

5. Click Next, and select Local printer attached to this computer in the following 
dialog box: 
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Figure-135 

6. Continue to click Next, and the following dialog box appears. Select Create a new 
port, and select Local Port in the dropdown menu. 

 
Figure-136 
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7. Click Next, and the following dialog box appears: 

 
Figure-137 

8. Enter the port name: “\\.\pipe\Pipe Print Template name”, we will use “\\.\pipe\Epson 
4800” as an example, and click OK.  

9. The Install Printer Software dialog box appears. Please select the correct 
manufacturer and printer model, then click Next. In the next pop-up dialog boxes, 
please select Next all the time, till you finish the addition of the printer. When you have 
finished the addition, an icon for the selected printer as in the “Epson 4800” template will 
be displayed in the Printers and Faxes window. 

5.2.2 Install Adobe PS Printer 

The driver of Adobe PostScript Printer driver is available from the Adobe website 
(www.adobe.com). You can refer to the Installation Guide or Readme for the installation 
of the Adobe PS Printer. Some of the steps, however, need to be explained. 

1. When presented with the option of choosing a Local Printer or a Network Printer, 
select a Local Printer. 

2. When selecting PPD, it is recommended to use the PPD that is the same as that of the 
final output device. 

3. Select the pipe port that has been created when you are asked to select a print port. 

4. Select Shared when you are asked to share or not to share the printer. Input the share 
name and the local name of the printer. 

5. Now, you have finished installing a pipe printer and published a network printer. The 
network printer can be installed on any networked PC, the job data from which will be 
delivered to EagleDot through the pipe of “\\.\pipe\Epson 4800”. And EagleDot will RIP 
and output the file according to the setup of the template. 

5.3 How to Print from Mac on Network 

EagleDot also supports network printing from Mac.  

Note: You can perform network printing from Mac computers only when pre-RIP proof is 
enabled.  

To do this, please perform the following operations.  

5.3.1 Share a parameter template 

In most of the Windows operating systems, perform the following steps. Here we will use 
Windows Server 2003 as an example.  

Note: This operation is not supported in Windows XP operating system.  

1. Select Control Panel > Add or Remove Programs > Add/Remove Windows 
Components > Other Network File and Print Services, install File Services for 

http://www.adobe.com/�
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Macintosh and Print Services for Macintosh. 

2. Launch EagleDot and select System Settings from the Option menu, the System 
Parameter Setting window appears. Click the Template tab.  

 
Figure-138 

3. Check Enable template sharing on startup, and click OK. 

4. Create a Pre-RIP template and set its parameters. 

5. Click the Option menu and select the Share Parameter Template(s) command to 
open the Share Parameter Template window.  
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Figure-139 

6. Select the template (Epson 4800 as an example), and click the Share button.   

 
Figure-140 

7. Input a share name and click OK. And return to the previous window, the shared 
template will be indicated by an icon .   

 
Figure-141 

8. At this time, the template has been shared. You can click DeleteShared to cancel the 
sharing. 

5.3.2 Create a PPD file 

Launch the EagleDot, click the Option menu and select the Make PPD File command to 
open the window as shown in the following figure: 
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Figure-142 

First, select the type of PPD files. The default PPD type is For PC. Here we click For MAC. 

Next, select an item from the left pane, and click the Add button, here we select the 
“AGFA Avantra 44/44S” as an example. The selected option will be delivered to the right 
pane. If you want to delete the PPD from the right pane, click the file and click the Erase 
button. 

Then click OK, the PPD is created. The created PPD file will be saved under the path 
displayed at the bottom of the dialog box.  

When you have created the PPD file, please copy the file to the Mac computer.  

5.3.3 Settings in Mac Operating System 

When you have completed sharing the parameter template and created a PPD file in the 
Windows OS, you should go to the Mac OS and perform some related settings. Here we 
will use Mac OS X as an example.  

1. Click the  button and choose System Preferences > Print & Fax to open the 
Print & Fax dialog box.  

2. Click the “+” button to open the Printer Browser dialog box, and select the shared 
printer name.  
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Figure-143 

Here we will select the “LYZHANG-TEST/Epson 4800” as an example. “LYZHANG-TEST” 
refers to the name of the computer where EagleDot is located, and “Epson 4800” refers 
to the shared template created in Section 5.3.1. 

3. And in Printing Using, select Other to open the dialog box as shown in the following 
figure: 
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Figure-144 

4. Select the “AV44.PPD” created previously. Then click Open and return to the 
preceding dialog box, click Add to complete.  

If you are using Mac OS 9, please perform as follows:  

1. From the Apple menu of the Mac, select Chooser in the File menu. Select 
LaserWriter8 (if you have PS Printer installed, you may also select PS Printer) in the 
Chooser dialog box, and then select the shared template (“LIU-LING/Epson 4800” as an 
example) in the right column.  
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Figure-145 

2. Click the Setup button to connect to the selected PostScript printer. And then select 
the PPD of the printer. 

3. Click OK. You can see a printer icon is displayed on the desktop. 

Now, you can print files directly from layout applications on Mac OS. The file data will be 
delivered to EagleDot through the shared parameter template. And EagleDot will RIP and 
print the file according to the settings of the shared template. 

5.4 Auto Print - Hot Folder 

Hot Folder enables you to automatically submit and print a job. You can appoint a local or 
network folder as hot folder, and put the files that you want to process into the folder. 
EagleDot is able to detect appropriate files in the hot folder at a certain interval of time, 
and process the detected files according to the parameter setup. 

5.4.1 Define a hot folder 

Before you define a hot folder, please make sure that you have created a parameter 
template. To define a hot folder, click the Hot Folder button  in the toolbar. You will 
see the following window:  
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Figure-146 

If this is the first time for you have opened this window, click Add button to create a new 
hot folder. If this window has listed some hot folders, you can select one and click Modify 
to modify it, or click Delete to remove. Here we click Add to create a new hot folder.  

 
Figure-147 

Input a valid name and click OK. You will get the following window. 
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Figure-148 

In this window, you can set the following Hot Folder parameters: 

Interval: The system will detect the files in the hot folder at the set interval of time. By 
default, this interval is 10 seconds. You can customize the interval with values between 
5-60 seconds. 

Search Type: This is the file type that EagleDot detects in the hot folder. EagleDot can 
search the following file types in the hot folder: Multiple TIFF Files, EagleRIP 4.0 Files, 
EagleRIP 3.0 FMP Files, Single TIFF File, 1-bit tiff from HQ RIP, TIFF/IT, Scitex CT/LW and 
PreRIP Files. Please select the file type from the dropdown list. 

Note: 8 bit TIFF files and 1 bit TIFF files cannot be put together and be submitted as 
Multiple TIFF Files in the same hot folder. To automatically print 8 bit TIFF files, you must 
select the “Single TIFF File” search type.  

Template: You must select a parameter template for the hot folder. The files in the hot 
folder will be printed according to the selected template.  

Note: When a file in the hot folder is a 1 bit TIFF file, the system will use the naming rule 
defined in the template to identify its separation color plates of a file. Therefore, you 
should make sure the naming rule parameters are correctly defined. 

Hot Folder: You must specify a folder path for the hot folder. Click the  button to open 
the following dialog box. You can select an existing folder. 
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Figure-149 

Note that if you want to specify a network folder as the hot folder, ensure that you have 
the read and write privileges to the network folder. 

Include Subfolders: Determines whether the hot folder can include subfolders. If this 
option is checked, the subfolders created in the hot folder will also be regarded as hot 
folders. Files in these subfolders will be detected at a certain interval of time and 
submitted to EagleDot. 

Delete Files: If checked, EagleDot deletes the files in the hot folder after they have been 
printed.  

Move Files To: If checked, you can click the  button to specify a folder path, to which 
the files in the hot folder will be moved after they are printed.  

Note: You cannot assign a hot folder of any template as the destination folder where the 
files in hot folder will be moved. Otherwise, there will be an endless circulation. When the 
Search Type is set to “EagleRip 4.0 Files”, the “Delete Files” and “Move Files To” options 
will be unavailable and grayed out. 

You can only select one of these two options. 

Depending on the Search Type you selected above, the parameters shown below in the 
Submit Jobs window will vary. The following are the different parameters for each 
Search Type and the descriptions about their functions. 

1) If you select Multiple TIFF Files, or EagleRIP 3.0 FMP Files, or 1-bit tiff from HQ 
RIP, the Submit Jobs column will be displayed as follows: 
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Figure-150 

The files mentioned above usually contain multiple separation color plates, and these 
separation color plates may not arrive to the hot folder at the same time. In this instance, 
the software needs to know when all plates of a job have arrived before it can submit the 
job. There are two conditions under the Submit Jobs. You must select at least one of 
them to enable the hot folder to submit a job.  

If you select the first option and specify a time value (here we will use the default value 
of 10 as an example, the valid range is 5-3600), when no color separation plate arrives 
within the specified time period (10 seconds), the system will stop waiting and submit the 
file, even if some separation color plates have not arrived. 

If you select the second option and specify a number value (here we will also use the 
default value 4 as an example), when the number of the arrived separation color plates 
equals to the specified number (4), the system will also stop waiting and submit the file, 
even if some separation color plates may not have arrived. 

2) If you select EagleRip 4.0 Files, only one parameter will be displayed: 

 
Figure-151 

Its function is the same as the first option above.  

3) If you select PreRIP Files, the Submit Jobs will be replaced with File Formats: 

 
Figure-152 

Select the formats of the PreRIP files that the system will search for. For example, if you 
select PS, the system will search for the files that are defined in the PS format. You must 
select at least one option. 

4) If you select Single TIFF File or TIFF/IT, Scitex CT/LW, no Submit Jobs 
parameters will be displayed.  

Click OK to save the settings when you have determined all the parameters above.  
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5.4.2 Run a hot folder 

To run a hot folder, open the Hot Folder List window and click the  symbol in front of 
a hot folder, making it turn to . 

Congratulations! You have finished the setup of a hot folder. You are now able to drop files 
into the hot folder for processing by EagleDot.  

5.5 Page Ganging and Splitting 

5.5.1 Ganging 

In practice, you may encounter small size jobs such as A3, A4 or even smaller. Your 
digital proof device may only support large media. To avoid the waste of time and media, 
EagleDot provides an auto ganging function. 

1. In the printer setup window, check the Auto Page Position box as shown in the 
following figure: 

 
Figure-153 

2. In the Job Monitor, the job after RIPping goes to Waiting to Print queue. When you 
check Continue Print box to print the job, you will find the job is no longer visible in the 
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queue. Select View > Device Monitor or click the  button to activate the Device 
Monitor window. 

 
Figure-154 

3. Click the Show Buffer button, the following window appears. You can see the position 
of small pages on media. 

 
Figure-155 

4. Sometimes you may find that if a job is rotated 90 degree, it will be more suitably 
positioned on the media, however the auto-position function is not able to rotate the job. 
To realize rotation before position, please refer to the following steps:  

First, click Discard Buffer in the Device Monitor window. All the buffered jobs are 
delivered to the Printed Job queue, and each job is marked with a “(*)”, indicating that 
it has NOT been normally printed. Uncheck Continue Ripping and Continue Print in 
job monitor.  

Then, right-click the job that you want to rotate and choose Re-RIP. The job goes into 
the Waiting to RIP queue. After that, right-click it and choose Config Parameters. In 
the template parameter setup window, click Options > Page Setup, and change the 
rotate setting as needed. Now check Continue Ripping in job monitor.  

And then, delete the job that has just been re-RIPped in the Printed Job queue. Then 
select all of the rest jobs in that queue and click the button  in the toolbar, to move 
them into the Waiting to Print queue. And then check Continue Print, making all the 
jobs be buffered.  

Now open the Device Monitor window, you can see that the page is rotated.  

5. If you are satisfied with the ganging result, click Output to begin printing.  

6. During printing, if you want to stop printing, click the Abort button. 

7. The Auto Page Position function saves your time and material. Under certain 
circumstances, however, you may uncheck this option to disable the function. When 
unchecked, EagleDot will output each job separately without ganging.  
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5.5.2 Splitting 

The job size may sometimes be larger than the output media size. In this case, you have 
three options. The first option is to disable jobs exceeding media size, i.e. not to output. 
The second is to output a portion of the job. The third is to split the job and output in 
multiple pieces. 

By default, the Disable jobs exceeding media size option is checked. In this case, the 
output of an oversized job will not be allowed. If Disable jobs exceeding media size is 
unchecked, and no other related settings are defined, a portion of the oversized job will 
be outputted. 

Once Disable jobs exceeding media size is unchecked, the Auto Page Split option is 
activated. Check Auto Page Split to activate the X, Y edit boxes. In the edit boxes, you 
can specify the horizontal and vertical values of the overlapping area of split pages. See 
the following figure: 

 
Figure-156 

The oversized job will be split and printed. After output, the split pages can be assembled 
to form the entire image. 



Founder EagleDot User Guide 

 

 128 

5.6 Paper White Simulation 

A situation may arise that your proof does not accurately reflect a press proof because 
the quality of the output media is very high and the paper is too white. To resolve this 
problem, EagleDot provides a Paper White Simulation function. To explain briefly, the 
blank area on the proof paper will be screened slightly to simulate the appearance of the 
press sheet. 

To enable this function, open the Color Setting window. Under the General tab, you will 
find a Paper White Simulation option, which is shown in the following figure. 

 
Figure-157 
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When you check Paper White Simulation, the simulated white value of the press sheet 
will be reproduced in the blank areas of the proof.  

5.7 Proof for Single-Color and Two-Color 
Separations 

Proofs are mostly CMYK combined, and sometimes include a spot color. However, in some 
cases, single-color or two-color proofing is also necessary. EagleDot has functionality to 
meet these requirements.  

Open the Color Setting window and click the Advanced tab.  
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Figure-158 

By default, the Composite option is checked, and all the colors are selected. The default 
setting will generate color proof. If your printer is monochrome, you need to uncheck 
Composite, and the selected colors will be printed separately. If the Auto Page 
Position box in General Parameter tab is checked, the single-color proofs will be 
automatically positioned on the output page, to save you time and material. 

If you are using a two-color offset press, you need to check Composite, and the selected 
colors will be combined together. The following figure shows the setting if you want a 
two-color proof of Cyan and Yellow: 

 
Figure-159 

If there is spot color in the job, spot color and process color can be grouped in any way 
to output at your will. 
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Chapter 6 
System Parameters Settings 
Name Location Default value Range Unit 

Update file regularly Information window Checked -  

Keep Messages in file 
for __ days 

Information window 30 0-60 Day 

Alarm when warnings 
or errors indicated 

Information window Checked -  

Warning Frequency Information window 1000 200-2,000 Hz 

Warning Duration Information window 50 0-10,000 ms 

Error Frequency Information window 500 200-2,000 Hz 

Error Duration Information window 500 0-10,000 ms 

Erase oldest 
message when 
exceeding __ lines 

Information window 500 100-10,000 line 

Enable template 
sharing on startup 

Template Checked -  

Enable modifying the 
parameter template 
when printing 

Template Checked -  

EagleDot Path Other - -  

Temp Path Other - -  

Frame Bitmap Other - -  

When temp or 
FrameBMP disk space 
is less than(MB) 

Other 200 0-100,000 MB 

Auto-Delete printed 
files 

Other Checked -  

Prompt user when 
needed 

Other  -  

FrameBMP display 
memory size (MB) 

Other 4 1-8 MB 

Maximum abnormal 
jobs Other 100 0-100  

Maximum printed 
jobs allowed Other 256 0-1,000  

Maximum jobs in 
system Other 1000 0-1,000  

Continue printing 
after print error 

Other  -  



Founder EagleDot User Guide 

 

 132 

occurrence 

Monitor ICC Other  -  
 

System parameters include the parameters that affect the EagleDot system, such as the 
parameters related to working mode, file operating path, feedback information 
management, and etc. You can make appropriate settings to these parameters according 
to your favorite style, actual demands and the hardware environment.  

Note: System parameters may affect all the jobs, please be careful as you set or modify 
the values of these parameters. You must restart EagleDot to make the settings or 
modifications take effect. 

To set the system parameters, please choose from the main menu Option > System 
Settings to open the System Parameter Setting window. 

 
Figure-160 

This window is composed of three tabs: Information Window, Template, and Other. 

6.1 Information Window 

Parameters under Information Window tab involve the setups of system feedback, 
such as alarms when warnings or errors appear, the frequency and duration of warning 
and error alarms, and the number of displayed lines.  

Update file regularly: The message in the Information Window is saved in a system file 
named as InfoWnd.txt under …\Program Files\Founder\EagleDot\SysData. When 
checked, system will regularly update the message in the Information Window. When 
unchecked, system will permanently keep the message.  

Keep Message in file for __ days: When you select the Update file regularly box, 
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this option will be enabled. You can input a value in the edit box to specify how many days 
the message in the Information Window can be kept for. By default, the message will be 
kept for 30 days.  

Alarm when warnings or errors indicated: Through this option, you can control the 
system’s ability to issue alarms when warnings or errors are indicated in the course of 
processing jobs. When this option is checked, the system will issue sound alarms in 
specified frequency and duration. By default, it has been checked.  

Warning Frequency, Warning Duration, Error Frequency, and Error Duration: 
These four options will be enabled when you have selected the Alarm when warnings 
or errors indicated option. They are used respectively for controlling the alarm 
frequencies and durations when warnings or errors indicated.  

Test: The two buttons are used for testing the alarm sounds for warnings and errors.  

Erase oldest message when exceeding __ lines: By default, when messages exceed 
500 lines, the oldest messages will be deleted. The number can be customized. 

6.2 Template 

 
Figure-161 

Enable template sharing on startup: If checked, when EagleDot is launched, the 
shared templates will be automatically published for network printing from Mac.  

Enable modifying the parameter template when printing: When selecting files to 
output, the user can modify the current selected parameter template. If this option is 
checked before the modification, the template will be permanently modified. If not 
checked, the modification only takes effect in the current job.  
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6.3 Other 

 
Figure-162 

EagleDot Path: The path where EagleDot is installed. 

Temp Path: The path of the temporary files. By default, the path is …\Program 
Files\Founder\EagleDot\Temp. You may select another temp path by the Browse button. 

Frame Bitmap: Frame bitmap is the bitmap files generated after RIP process. Frame 
bitmap path is the directory where bitmap files are saved. The default frame bitmap path 
is EagleDot\FrameBMP\. It is recommended to set a frame bitmap path in the hard disk 
with the largest free space, so as to store as many bitmap files as possible. 

Auto-Delete printed files: On the lower-left part of the window you can define the 
minimum free space on the Temp or FrameBMP disk. The default is 200 MB, which can be 
re-defined. If this checkbox is selected, the printed files will be automatically deleted 
when the free space for Temp or FrameBMP disk space is less the defined minimum value. 

Prompt user when needed: When the free space is less than the minimum value, 
system will remind user to manually delete files to keep enough free space. 

FrameBMP display memory size (MB): When displaying bitmap in preview, system 
needs to apply a cache named FrameBMP Display Memory to speed up displaying bitmap. 
Once the preview window is closed, the display memory will be released. The default 
FrameBMP display memory size is 4MB. 

Maximum abnormal jobs: During RIPping, if a job is aborted or stopped by an error, 
the current job will be taken as an abnormal job and left in the Waiting to RIP queue. 
The default is 100.  

Maximum printed jobs allowed: The printed jobs remain in the queue to be viewed 
and printed. The default maximum number is 256. This number should not be too large; 
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otherwise, it would take up a lot of space.  

Maximum jobs in system: When the total job number in Waiting to RIP, Waiting to 
Print and Printed Job queues exceeds the defined maximum number, system will 
refuse to do new RIP jobs. You can change the setting according to the memory and hard 
disk conditions. The default is 1000. 

Continue printing after print error occurrence: Determines whether the system will 
continue printing when print errors occur. 

Monitor ICC: You can specify a monitor ICC by selecting its path. 

Note: You must exercise great caution when modifying system parameters, which will 
affect all jobs. You must restart EagleDot to make the new system settings take effect. 
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Chapter 7 Fonts 
7.1 Install Fonts 

EagleDot will automatically install some fonts during the installation of this software. 
Note that when installing fonts for Macintosh, you need to share parameter template with 
Macintosh. Refer to Section 5.3.1 for information about sharing parameter template. 

7.2 Fonts Management 

7.2.1 Add Fonts 

You can add other fonts in form of .pfa or .pfb font files after you have installed EagleDot. 
To install such fonts, choose from the main menu Font > Add.  

 
Figure-163 

Click the Browse button to select the directory or folder where the .pfa or .pfb font files 
are located and click OK, the fonts in the selected directory or folder will be installed. 
After you have added the fonts, please perform the Reset operation (see below). 

7.2.2 Remove Fonts 

You can remove the installed fonts. Choose from the main menu Font > Remove.  

 
Figure-164 
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Select the fonts you want to remove from the left pane and click the Remove button, the 
selected fonts will be moved into the right pane. To cancel removing a font, please select 
the fonts you want to remove from the right pane and click the Add button.  

Then click OK, all the fonts in the right pane will be removed. The system will pop up a 
reminder for you to confirm before the removal.  

7.2.3 Substitute Fonts 

You can establish and maintain a font substitution table, mapping an absent font with an 
existing font in the system. When an absent font is encountered in the course of printing, 
the system will automatically use the specified font in the table to substitute the absent 
font. The default font to substitute the absent font is Courier. 

To establish a substitution table, please choose from the main menu Font > 
Substitution Table.  

 
Figure-165 

Please click the Add button to add an absent font. When the Add button is clicked, the 
Add One Absent Font dialog box will be opened. Input the absent font, and click OK. 
The absent font will be added to the left Absent Fonts pane. 

 
Figure-166 

Then select a substitute font in the right pane and click OK. The mapping relation will be 
established. And you can repeat the operations above to add more mapping relations.  

You can modify the mapping relation between an absent font and a substitute font. 
Please select the absent font and select its substitute font, then click OK to modify. 

You can also delete a mapping relation. Please select an absent font and click the Delete 
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button, the mapping relation for the absent font will be removed.  

Note: During RIPping in EagleDot, the absent font is automatically added to the Absent 
Fonts list. If an absent font listed in the Absent Fonts list is installed later on, the font 
name will remain on the list, but does not take effect. All the fonts-related actions should 
be executed from the Font menu, rather than from the hard disk to avoid error.  

7.2.4 Reset Fonts 

The Reset command in the Font menu is used to reset all the font files. When the Reset 
command is clicked, the Reset Fonts dialog box will be opened. 

 
Figure-167 

The Font Directory is the directory where the font files are located. The Use system 
TrueType fonts checkbox enables you to add or delete standard TrueType fonts. Check 
the box and click OK and the TrueType font files will be added to the font directory. 
Uncheck the box and click OK, the TrueType font files will be removed from the font 
directory.  

Click OK, and the system will reset the font files in that directory. The Information 
Window will display detailed results. For example:  

 
Figure-168 

Tip: Perform this Reset operation whenever you have finished the Add, Remove or 
Substitute fonts operations, especially the Add operation.  
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Chapter 8 
EagleDot User Interface 
Double-click the EagleDot shortcut on desktop to launch the application. The main 
interface of EagleDot is shown as in the following figure: 

 
Figure-169 

The main interface of EagleDot consists of the following parts: menu, toolbar, job monitor, 
two sub-windows (Information Window and preview window) and the status bar.  

The menu provides the menu commands that are needed to execute various operations.  

The toolbar provides the tool buttons for common operations, such as opening files, 
creating templates, setting hot folder, editing spot color, editing curves, making color 
calibration solutions, opening device monitor and etc.  

The job monitor is used to manage and control jobs. It consists of three job queues: 
Waiting to RIP, Waiting to Print, and Printed Job.  

The Information window displays related information.  

The preview window enables you to preview the print result.  

The status bar shows the function description of the corresponding tool or menu item 
when cursor is placed on toolbar or a menu item.  

Note: If you have not correctly installed the dongle, at the time when you launch 
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EagleDot, the Information Window will remind you with this message, “This is a demo 
version, unlicensed for commercial use”.  

8.1 Menu 

The menu bar consists of five dropdown menus, by which you can communicate with 
EagleDot interactively. 

 
Figure-170 

The under-lined letter indicates the hot key of the corresponding menu item. Press the 
Alt key and the letter at the same time, to select the item. Some of the commands in the 
sub-menu can be executed by hot keys such as Ctrl+ “X”.  

8.1.1 File 

 
Figure-171 

Open File (RIP) 

This command is used for opening files.   

Parameter Template(s) 

This command is used for creating and modifying parameter templates.  

Input RIP Option Key 

 
Figure-172 

Pre-RIP proof is provided for you as an option in EagleDot. Therefore, you need to input 
the RIP option key to activate the option. This activation can also be done during the 
installation. 
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Import Parameter 

Import the parameters that have been previously exported.  

Export Parameter 

Select this command to open the Save As dialog box, you can export all the parameter 
templates in the system and their related parameters, and save as an .fzp file.  

Exit 

You can close EagleDot by choosing this command.  

8.1.2 Option 

 
Figure-173 

Clear Information Window contents  

The contents in Information Window will be cleared.  

Units Setting 

EagleDot supports three units: Millimeter, Inch, and Point.  

System Settings 

Select the command to open the System Parameter Setting window.  

Reset System Settings 

If EagleDot does not run normally due to the improper system settings, this function can 
reset all the system parameters except for the Parameter Template path, Temp Path and 
Frame Bitmap to the default settings. 

Note: Please take caution in using this function, as all the current system settings will be 
replaced by default system settings. A prompt window will appear, asking you to confirm 
the action.  

Share Parameter Template(s) 

The command is used for sharing parameter templates for network printing from Mac.  

Make PPD File 

Generate PPD files by this command. 

8.1.3 Font 

The commands in the Font menu are designed for managing font files in EagleDot. 
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Figure-174 

Add 

This command is used for adding or updating fonts in EagleDot. 

Remove 

This command is used for deleting fonts from EagleDot. 

Substitution Table 

In the font substitution table, you can specify the substitution font for the absent font.  

Reset 

This command is used to reset the font files. 

8.1.4 View 

 
Figure-175 

Toolbar 

The tool bar is displayed when this command is selected.  

Status Bar 

The status bar is displayed when this command is selected.  

Device Monitor 

If this command is selected, the Device Monitor will be displayed. The Device Monitor 
command is disabled when there is no printing job. 

Quick View 

The Preview window is displayed when this command is selected.  

Information Window 

When the command is selected, the Information Window will be displayed. The 
Information Window shows the prompt, alert and error information.  

Default Windows 

You can restore the default windows by selecting this command.  
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8.1.5 Help 

 
Figure-176 

Dongle Info 

This command will display a window showing the dongle information. You can save this 
information into a text file, which may be required when updating your EagleDot.  

 
Figure-177 

Update Dongle 

By clicking this command, you can open a pkg file to update your dongle.  

About 

This command will display the version and copyright information of EagleDot.  

8.2 Tool Bar 

Tool bar is a combination of icons: 

 
Figure-178 

Tool bar is an integration of most commonly used commands. Each button on the tool bar 
corresponds with a command in the main menu. See the following table: 

Icons Functions Reference 

 
Open File(RIP) Section 2.3.1 

 
Parameter Template Chapter 3 

 
Hot Folder Section 5.4 

 
Spot Color Section 4.1 
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Color Solution 

Color Calibration 
Guide 

 Color Tune curve Section 4.2 

 
Device Monitor Section 2.3.1 

 
Move up a selected job in the Printed 
Job/Waiting to Print queue Section 5.1.1 

 
Move down a selected job in the Printed 
Job/Waiting to Print queue Section 5.1.1 

 

Move a selected job in the Printed 
Job/Waiting to Print queue to the 
Waiting to Print/Printed Job queue 

Section 5.1.3 

 
About EagleDot Section 8.1.5 

 

8.3 Job Monitor 

The job monitor is used for monitoring and controlling job progress. It consists of three 
job queues, two progress bars and some operating options. 

Job Queues 

Waiting to RIP: Lists the jobs that are waiting to be RIPped. It contains two columns: 
Waiting to RIP, and Status, which respectively display the job names and status.  

 
Figure-179 

Waiting to Print: Lists the jobs that have been RIPped and be waiting to be printed. It 
contains four columns: Waiting to Print, Page Size, Template Name, and Status. The job 
names, their page sizes, the templates that they use and their status will be listed.  

 
Figure-180 

Printed Job: Lists the jobs that have been printed.  
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Figure-181 

The widths and heights of these three queues and their columns can be randomly 
adjusted by the user.  

RIP and Print 

Once Continue Ripping is checked, the jobs in Waiting status in Waiting to RIP 
queue will be processed one by one. Otherwise, the jobs remain in Waiting to RIP 
queue waiting to be RIPped.  

Once Continue Print is checked, the jobs in Waiting status in the Waiting to Print 
queue will be processed one by one. Otherwise, the jobs remain in Waiting to Print 
queue waiting to be printed.  

Note that EagleDot can remember the states (i.e. checked or unchecked) of the 
Continue Ripping and Continue Print boxes, and therefore will keep their latest states 
at your next reboot.  

Progress bar and Abort 

The progress bar on the right of the Continue Ripping or Continue Print boxes will 
display the RIPping or printing progress.  

If you click the Abort  button when a job is in the process of RIPping or in the process 
of printing, the process will be aborted.  

8.4 Information Window 

 
Figure-182 

Information Window shows the system working condition and normal, error and alert 
information. You can uncheck the Information Window command from the View 
menu to hide the Information Window. And this window can be adjusted to any size. 

8.5 Preview Window 

The Preview window displays the print result in advance.  
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Figure-183 

By unselecting the Quick View command form the View menu, you can hide this 
window. And the size of this window can be randomly adjusted as well.  

8.6 Status Bar 

The status bar is a thin gray bar located at the bottom of the main interface. 

 
Figure-184 

The contents in the status bar are variable. When cursor is placed on toolbar or a menu 
item, the status bar shows the function description of the corresponding tool or menu 
item. You can also hide the status bar by unselecting the Status Bar command from the 
View menu. 
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Appendix A: 
Device List and Dongle Level 
EagleDot digital proof system supports various printers of CANON, EPSON and HP. Each 
device model is supported by a dongle of certain level. The lower levels of dongles can be 
substituted by higher levels except for Level 8.  

For details on device list and dongle support, please email to GAsupport@founder.com.  

Canon iPF: 

Device model Dongle Device model Dongle 

Canon iPF 500 
Canon iPF 510 
Canon iPF 600 
Canon iPF 610 
Canon iPF 5000 
Canon iPF 5100 
Canon iPF 6100 

Level 1 

Canon iPF 650 
Canon iPF 655 
Canon iPF 700 
Canon iPF 710 
Canon iPF 6000S 

Level 2 

Canon iPF 750 
Canon iPF 755 
Canon iPF 810 
Canon iPF 815 
Canon iPF 820 
Canon iPF 825 

Level 3 

Canon iPF 8000 
Canon iPF 8000S 
Canon iPF 8010S 
Canon iPF 8100 
Canon iPF 8110 
Canon iPF 9000 
Canon iPF 9000S 
Canon iPF 9010S 
Canon iPF 9100 
Canon iPF 9110 

Level 4 

 

Epson: 

Device model Dongle Device model Dongle 

Epson Stylus Pro 4900 
Epson Stylus Pro 4880 
Epson Stylus Pro 4800 
Epson Stylus Pro 4450 
Epson Stylus Pro 4400 
Epson Stylus Pro 4000 
Epson Stylus Pro 3800C 
Epson Stylus Color 3000 
Epson Stylus Color 1520 
Epson Stylus Photo 2400 
Epson Stylus Photo 2100 
Epson Stylus Photo 1390 
Epson Stylus Photo 1290 

Level 1 

Epson Stylus Pro 7900 
Epson Stylus Pro 7890 
Epson Stylus Pro 7880 
Epson Stylus Pro 7800 
Epson Stylus Pro 7700 
Epson Stylus Pro 7600 
Epson Stylus Pro 7500 
Epson Stylus Pro 7450 
Epson Stylus Pro 7400 
Epson Stylus Pro 7000 
Epson Stylus Pro 5500 

Level 2 
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Epson Stylus Pro 9900 
Epson Stylus Pro 9890 
Epson Stylus Pro 9880 
Epson Stylus Pro 9800 
Epson Stylus Pro 9700 
Epson Stylus Pro 9600 
Epson Stylus Pro 9500 
Epson Stylus Pro 9450 
Epson Stylus Pro 9400 
Epson Stylus Pro 9000 

Level 3 

Epson Stylus Pro 11880 
Epson Stylus Pro 10600 
Epson Stylus Pro 10000 
Epson Stylus Pro 10000CF 

Level 4 

Epson AcuLaser C8500 Level 8   

 

HP: 

Device model Dongle Device model Dongle 

HP DesignJet 130 
HP DesignJet 120 
HP DesignJet 50PS 
HP DesignJet 20PS 
HP DesignJet 10PS 

Level 1 

HP DesignJet 750C 
HP DesignJet 650C 
HP DesignJet 450C 
HP DesignJet 350C 
HP DesignJet Z3100 
HP DesignJet Z2100 

Level 2 

HP DesignJet 3500CP 
HP DesignJet 3000CP 
HP DesignJet 2500CP 
HP DesignJet 2000CP 
HP DesignJet 1055CM 
HP DesignJet 1050C 
HP DesignJet 800 
HP DesignJet Z5200 
HP DesignJet Z3200 
HP DesignJet T1300 
HP DesignJet T1200 
HP DesignJet T1100 
HP DesignJet T790 
HP DesignJet T770 

Level 3 

HP DesignJet 5500 
HP DesignJet 5500PS 
HP DesignJet 5000 
HP DesignJet 5000PS 
HP DesignJet 4000 
HP DesignJet Z6200 
HP DesignJet Z6100 
HP DesignJet L25500 

Level 4 
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Appendix B: Hot Keys 
Key Combination Functions 

Ctrl + P Open File(RIP) 

Ctrl + T Parameter Template 

Ctrl + S System Settings 

Ctrl + B Share Template 

Ctrl + F Generate PPD files 

Ctrl + I Show Information Window 

Ctrl + V Show Preview window 

Ctrl + D Show Device Monitor 

‘+’ Zoom in 

‘-’ Zoom out 
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Appendix C: Rename 
When RIP products such as Founder EagleRIP RIPs the pre-separated source files, such 
as PostScript files, it will generate the 1 bit TIFF files. When the 1 bit TIFF files are created, 
a sequentially-increasing number will be added to the name of each separation file. The 
names generated by such a naming rule are not regular, and therefore, they cannot help 
EagleDot identify the pages and the separations in each page.  

EagleDot provides a rename tool to resolve this problem. It can change the name of a 1 
bit TIFF file generated from pre-separated files to a regular name, facilitating EagleDot to 
correctly identify and process such files.  

You can find a Rename.exe file under the Bin folder of the EagleDot install directory. 
Double-click the file to run the Rename program. You can also start this program by 
selecting Start > All Programs > Founder EagleDot > Rename. When the program 
is started, the window shown in following figure will pop up.  

 
Figure-185 

First, you need to specify the path where the source files are located from the Source 
Path edit box. Then, specify the target location for the renamed files in the Target Path 
box.  

Note: Because the renamed file will be moved into the Target Path, you must have the 
write privileges to the specified target path.  

In the separation ID edit box, input the IDs that represent the separations. For example: 
Cyan, Magenta, Yellow, Black or C, M, Y, K, and etc, depending on the actual condition of 
the source file.  

From the Color Order dropdown list, select the order of the colors in the page of the 
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source file. It may be CMYK, KCMY or Random.  

Name Rule dropdown list is used to setup the name rule for the source file. Please select 
one option according to the actual conditions of the source file.  

Due to that there is sequentially-increasing number in the source file name; you need to 
specify a minimum number included in the source file name in the First Page edit box, 
and specify a maximum number in the Last Page edit box.  

A report file will be generated after you have successfully renamed the file. This file 
records the detailed information about the renaming. You can specify its name and path 
in the Report file edit box.  

Note: In case that the source file misses one or more basic separations, this tool may not 
be applied. For example, this tool may not be applied to a source file that its first page 
contains only C and M separations, and its second page contains only Y and K separations. 
And, each of the color separation names defined should correspond to the color 
identifiers in the actual jobs, otherwise, the job cannot be correctly combined.  
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